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Conflict of Interest

MSU policy requires that faculty and research staff annually disclose all significant financial interests and
other opportunities for tangible personal benefit that are related to their institutional responsibilities.
(Please see coi.msu.edu for more information.) The Kuali Coeus (KC) Conflict of Interest (COI) module
allows faculty and academic staff (Reporters) to fulfill this obligation through the creation and
submission of an Annual Disclosure, Project Disclosure, and/or Travel Disclosure.
There are two separate but related components associated with the KC COI module: Disclosures and
Financial Entities. The Financial Entity records in KC are linked to the Reporter’s Disclosures in KC.
Together, the Financial Entity records and Disclosure records comprise a Reporter’s Conflict of Interest
Disclosure.
The KC COI module allows:







The Reporter to meet the requirement for the submission of an Annual Disclosure.
The Reporter to disclose all personal financial interests relating to a new research project or
other Proposal, Institutional Proposal, and/or Award (Project Disclosure).
The Reporter to relate a new significant financial interest to existing projects (update the Annual
Disclosure).
The Reporter to report sponsored or reimbursed travel for compliance with Public Health
Service (PHS) regulations (Travel Disclosure).
The Reporter to create, revise, and deactivate information about entities in which he/she has a
financial relationship (Financial Entities).
The Financial Conflict of Interest Officer (FCOIO) to review disclosures, assign disclosures to
appropriate faculty for additional review, and manage potential conflicts of interest, in order to
ensure compliance with federal and state regulations and University requirements.
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Disclosures
Overview
Before you start to use the COI Disclosures function in KC, it is important to have an understanding of
how the system has been locally configured. The local system configuration and compliance policy, the
relevant records, and interaction with the system determine the Reporter’s disclosure reporting
requirements in the COI Disclosure document.
For an overview on Michigan State University policy on Financial Conflict of Interest, please see the
website at coi.msu.edu, which includes links to MSU policy and to Conflict of Interest training videos and
other information.

Business Needs and Purpose
The core business requirement met by the KC Conflict of Interest module is to assure that MSU is in
compliance with all federal, state, and institutional regulations relating to conflict of interest.
The Disclosure document is completed:
 To meet the requirement for annual conflict of interest disclosure (Annual Disclosure)
 To disclose all personal financial interests relating to a new project -- research or other proposal,
Institutional Proposal, and/or award (Project Disclosure)
 To relate a new significant financial interest to existing projects (Updating Annual Disclosure)
 To report sponsored or reimbursed travel for compliance with Public Health Service (PHS)
regulations (Travel Disclosure)

Policy
Institutional policies generally require that officers, faculty, staff, and others acting on its behalf avoid
ethical, legal, financial, and other conflicts of interest and ensure that their activities and interests do
not conflict with their obligations to the institution. Disclosure of financial entities enables the
institution to determine if a financial interest creates a conflict of interest or the appearance of a conflict
of interest. The existence of a conflict or the appearance of one does not imply wrongdoing and does
not necessarily mean that a researcher may not retain his or her financial interest and undertake the
affected research. Often, the institution can work with the researcher to manage a conflict or
appearance of a conflict so that the research can continue in a way that minimizes the possibility of a
bias and preserves the objectivity of the research. Proper management depends on full and prompt
disclosure. MSU’s Conflict of Interest Policy is available and explained at coi.msu.edu.
Kuali Coeus provides the ability to disclose and maintain your significant financial interests; identify
potential areas of concern related to your proposals, institutional proposals, and awards; and disclose
sponsored/reimbursed travel for compliance with PHS initiatives.
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Roles and Responsibilities
The primary responsibilities for each actor in this procedure are:


The Reporter is responsible for entering/selecting, submitting, and maintaining disclosure
information.



The COI Administrator is responsible for reviewing disclosures submitted by the Reporter, and
communications with the Reporter regarding management and mitigation of potential conflicts
of interest. The COI Administrator may assign disclosures for review by specially assigned
Reviewers, as needed (generally rare). However, in KC the COI Administrator ultimately
approves or disapproves all disclosures.



The Reviewer is responsible for reviewing specific disclosures assigned to him/her by the COI
Administrator.

The generic actor Reporter (view/edit) in this procedure may refer to any of the following equivalent
applicable job titles:


Principal Investigator, Research Staff, Faculty/Academic Staff.

The generic actor COI Administrator (view/edit) in this procedure may refer to any of the following
equivalent applicable job titles:


Financial Conflict of Interest Officer, COI Administrator/Staff.

The generic actor Reviewer (view/edit) in this procedure may refer to any of the following equivalent
applicable job titles:


Research Faculty, departmental faculty, outside expert.

Document Layout
The COI Disclosure document is comprised of a header area, tabbed pages (Disclosure, Disclosure
Actions), and an action button area. The Disclosure Actions tab is not presented to Reporters; it is only
displayed to COI Administrators and Reviewers.
Table - COI Disclosure Document - Major Components Overview

Major Document
Component

Summarized Description

Header area

Document identification information at the top, right of the document containing both
common and document-specific fields.

Tabbed Pages

Pages that make up the document, which are accessible by clicking the folder tab. These are
groupings of functionally related information for the purpose of display.

Tabbed Page Panel and
Subpanels

Multiple panels on page contain data entry/selection/display fields that may be expanded
and collapsed via hide/show buttons. Some panels contain subpanels – the labels for which
are highlighted in a darker shade of grey.

Action Buttons

Buttons that appear at the bottom, center of the document (regardless of page), some of
which are common to all E-docs, and some of which are unique to this particular document.
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Document Header
The document header in the COI document (top, right corner of screen) displays six fields with systemmaintained identifying information about the disclosure record. The new Disclosure document is
automatically assigned a Document Id by the system with status In progress. Status is reassigned by the
system as actions are taken for the disclosure.

Figure - COI Document – Document Header

Table -Document Header Definition Disclosure Document

Field

Description

Document ID

This is a number that uniquely identifies the document currently accessed and displayed.

Disposition
(label: Status)

The administrative status of the disclosure. System determined until submitted for review, whereupon it is
set by the COI Administrator
(Maintenance: Compliance > COI > COI Disposition Code)

Disclosure:
Review Status

COI Disclosure Status: COI Review Status
COI Disclosure Status is the procedural status of the disclosure in the submission/review/approval process.
System –determined until re-set by the COI Administrator. (Maintenance: Compliance-COI>COI Disclosure
Status)
COI Review Status is the procedural status of the disclosure in the review process. System-generated until reset by the COI Administrator. (Maintenance: Compliance-COI>COI Review Status

Reporter:
Created

The MSU Net ID of the Reporter who created this document and the creation date of the document.

Last Updated

The time and date that this document was last changed and saved.

Disclosure
Number

This number is the unique number identifying this Disclosure. (The number is unique for each Reporter;
subsequent disclosures use the same Disclosure Number, with a sequence number to make the disclosure
unique.) This is a system generated, sequential number.

Pages
The Reporter’s Disclosure document is comprised of a single Disclosure tab. Administrators and
Reviewers are presented with the additional Disclosure Actions tab.
Disclosure Procedure
Disclosures are completed to be compliant with MSU, State of Michigan, and federal policy:
 Annual Disclosures are required to be submitted by all faculty and research staff;
 Project Disclosures are required to be submitted by all Investigators and Key Personnel
before a research proposal is submitted;
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Travel Disclosures are required to be submitted by Investigators and Key Personnel on any
U.S. Public Health Service funded project when they have completed any sponsored or
reimbursed travel.
It is advised that Reporters review and update their financial entities, as appropriate, when
submitting Disclosures. Entities may be added and updated at any time, but should always be
reviewed for accuracy prior to creating any disclosure. Note that Financial Entities are part of a
person’s disclosure, but are a separate action within the KC COI module.
Scope
This procedure covers:


Create Annual Disclosure



Create Project Disclosure



Create Travel Disclosure



Update Annual Disclosure

Navigation Path
Getting started – this quick system reference depicts how to access the start screen for this procedure.
Create New
Researcher > Conflict of Interest > COI Disclosures >

Create New/Annual Disclosure
Complete Disclosure for a Research Proposal
Complete Sponsored/Reimbursed Travel Event
Update My COI Disclosure

Access Existing
Researcher > Conflict of Interest > Disclosure Information > View All My Disclosures

Disclosure Statuses
COI Disclosure status is a document-specific status that describes where the disclosure is in the lifecycle
process.
The Disclosure document’s status changes throughout its lifecycle as follows:
Table - Disclosure Document - Document-Specific Status Descriptions

COI Disclosure Status

Description

In progress

Initial status upon initiating a new disclosure or updating a disclosure (system designated)

Routed for Review

Status upon submission and during the review process (system designated)

Review Completed

Status if approved by the COI Administrator

Disapproved

Status if disapproved by the COI Administrator
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COI Disposition Status: This status provides information about the relationship between a financial
entity and a project. (A project can be a proposal, institutional proposal, award, or the Reporter’s daily
work at MSU.) During the disclosure procedure, the Reporter is presented a limited set of values (Not
Related, No Conflict Exists, Potential Relationship, and Relationship Identified) to describe each entityto-project relationship. A Reporter may have several entities and several projects, so numerous
relationships may need to be qualified with a Disposition code.
The system uses the numeric code assigned to each COI Disposition Code to determine which
disposition code is displayed in the header panel of the disclosure. The relationship with the highest
code number is displayed. Higher values were assigned to the more “serious” relationships (i.e., those
with possible or known conflict of interest) so the most serious type of relationship is shown in the
disclosure header.
When reviewing submitted disclosure, the COI Administrator can override any Reporter-selected
disposition code with any value existing in the COI Disposition Code maintenance table.

Figure - COI Disclosure document/Document header/Status

COI Review Status: The COI Review Status provides information about which stage of disclosure review
lifecycle the disclosure is in. Some of the statuses are automatically set by the system while the COI
Administrator can override others. The COI Administrator can set the COI Review Status through the
Administrator Actions panel. Only the values that can be set by the COI Administrator (Assigned To
Reviewer, Assigned Review Complete, Received in COI office, and Awaiting additional information) are
available for selection by the COI Administrator.
Table - KC/Maintenance/Compliance – Conflict of Interest/COI Review Status

COI Review Status

Description

Who updates?

In Progress

This status indicates that the disclosure
is in progress.

Status set automatically by the
system when a disclosure is initiated.
COI Administrator cannot override or
update this value.

Submitted For Review

This status indicates that the disclosure
has been submitted for review.

Status set automatically by the
system when a disclosure is
submitted. Administrator cannot
override or update this value.

Assigned To Reviewer

This status indicates that the disclosure
has been assigned to one or more
reviewers.

Status set automatically by the
system when reviewers are assigned
to the disclosure, and can be
manually set by the Administrator.

Assigned Review Complete

This status indicates that all reviewers
who have been assigned to review the
disclosure have completed their review.

Status set automatically by the
system when all assigned reviewers
to the disclosure have completed
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COI Review Status

Description

Who updates?
their review. COI Administrator can
manually override this status.

Review Complete

This status indicates that the COI
disclosure has reached a terminal state
of “approved” or “disapproved” and
that the disclosure review is complete.

Status set automatically by the
system when the COI Disclosure
status is either Approved or
Disapproved. Administrator cannot
override or update this value.

Received in COI office

This status indicates that the COI office
has received the disclosure but no
action has been taken.

Status set manually by the COI
Administrator.

Awaiting additional information

This status indicates that additional
information about the disclosure has
been requested of the Reporter or
other party.

Status set manually by the COI
Administrator.

Under Review by COI Reviewer

This status indicates that the disclosure
is in the process of being reviewed.

Status set manually by the COI
Administrator.

Maintenance Note: The values for COI Review Status are maintained within the COI Review Status table.
A “Yes” value in the column “Status Updates only through Action” indicates these values can only be set
by the system and cannot be overridden by the Administrator. A “No” value indicates that the value
might be set by the system but can be overridden by the Administrator.

Annual Disclosure
The Reporter’s Annual Disclosure document (KC COI Disclosure page) consists of one tab (Disclosure).
There is a Questionnaire panel on this tab, which is empty unless locally configured. MSU has not
configured the Questionnaire panel: instead, a Screening Questionnaire panel appears and the Reporter
is required to answer it. The Reporter can update the previously answered screening questionnaire,
update financial entity relationships, and submit the annual disclosure to the COI office.
Composition of an annual disclosure: The Reporter’s annual disclosure contains all of the Reporter’s
previously approved Travel and Project Disclosures. The system Reporter maintains a master disclosure,
which is an aggregation of all of the Reporter’s approved travel and project event disclosures, to create
annual disclosures after the initial annual disclosure has been completed. However, MSU does not use
the term “Master Disclosure” in outward facing pages. Disapproved disclosures are not included in the
annual disclosure.
 Undisclosed projects: If the Reporter has undisclosed projects (i.e., project disclosures that were
not completed) at the time of the annual, these projects appear within the annual disclosure.
The Reporter can disclose for these projects from within the annual without needing to submit a
separate project disclosure.


Travel Disclosures within Annual: Travel Disclosures appear in the Reporter’s annual disclosure
if the “Exclude from Annual Disclosure” checkbox has been set to “No” within the Maintenance
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record for the manual project. The Maintenance record can be accessed through Maintenance>
COI Disclosure Event Type and editing the manual project.
 MSU Daily Activities: MSU has implemented the automatic creation of a “project” for each
Reporter called “MSU Daily Activities.” The existence of this “project” for every Reporter allows
the system to display the Reporter’s disclosed Financial Entities to the COI Administrator.
Lacking this auto-created project, the COI Administrator could not view the Reporter’s disclosed
entities if the Reporter had no other projects in the system.
Annual Disclosure date setup: Based on institutional practices, annual disclosures can be set up on a
fixed date or a rolling date basis. MSU has established rolling annual disclosures, implemented as of the
KC COI module pilot and go-live date.
Setting up annual disclosure as fixed or rolling
 Fixed date annuals: This date set-up for annual disclosures is used when the implementing
institution has a well-defined time period as to when annual disclosures should be submitted.
The system provides a date parameter ANNUAL_DISCLOSURE_RENEWAL_DATE that needs to be
populated with the date in MM/DD/YYYY format.
The date can also be specified in the
MM/DD format.

Figure - System Admin/Parameter/ANNUAL_DISCLOSURE_RENEWAL_DATE

 Rolling Annuals: This date set-up for annual disclosures is used when the implementing
institution requires Reporters to submit an annual a year from the approval of the last annual
disclosure. The system provides a date parameter ANNUAL_DISCLOSURE_RENEWAL_DATE that
needs to be populated with “0” to indicate that annual date set up is of the rolling annual
disclosure type. MSU has implemented the COI module with the requirement for rolling annual
disclosures.

Informing Reporters that annual is due: Irrespective of whether the implementing institute sets up the
annual disclosure as a fixed date annual or a rolling annual disclosure, a parameter can be set to inform
the Reporter that their annual disclosure is due.
 The system provides the parameter ANNUAL_DISCLOSURE_ADVANCE_NOTICE that takes in
input in the form of a number.
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Figure - System Admin/Parameter/ANNUAL_DISCLOSURE_ADVANCE_NOTICE

The number (e.g. 30) represents the days in advance of the due date for the next annual
disclosure, from when a message informing the Reporter that their annual disclosure is due will
be displayed to the Reporter in the KC landing page.



For fixed date annuals, the system displays the message “Your annual disclosure is due.”
from 30 days prior to the date specified in the parameter
ANNUAL_DISCLOSURE_RENEWAL_DATE.
For rolling date annuals, the system displays the message “Your annual disclosure is
due.” from 30 days prior to the current year’s date when the annual disclosure is due.

The system stops displaying the message when the Reporter submits another disclosure (annual,
project, or travel).

Create New/Annual Disclosure
To create an annual disclosure, the Reporter must navigate to a disclosure using the following path:
Researcher > Conflict of Interest > COI Disclosures > Create New/Annual Disclosure.
Reporters must disclose their significant financial interests (SFIs) annually, or whenever an SFI is
acquired. During the disclosure process, the Reporter will complete the following steps.
1.
2.
3.
4.
5.
6.
7.

Review your details in the Reporter panel.
Review and maintain additional units, if needed, in the Unit Details panel.
Answer the Screening Questionnaire question.
Relate your Financial Entities to your projects in the Disclosed Projects panel.
Enter a note or upload a document, if appropriate, in the Notes & Attachments panel.
Certify that the information is complete in the Certification panel.
Submit the disclosure.
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Reporter – Annual Disclosure
The Reporter’s information comes from the Person data associated with the logged in user. If any of the
contact details are incorrect, they can be updated in KC by a user with the appropriate roles via the
navigation path in System Admin > Identity > Person. Most KC implementations update/maintain this
Person data table with a regularly scheduled HR Data feed. The Reporter must have one unit designated
as a Lead. Units may be added, deleted, and designated as lead for use with the Financial Entities in that
subpanel, but changes here will not impact or update the Person record.

Figure - COI Annual Disclosure > Disclosure Page > Reporter Panel

Contact Information
The Reporter’s Contact Information is display only, populated from the Person data associated with the
logged in user. If any of the displayed data is incorrect, the data may be updated in KC by a user with the
appropriate roles via the navigation path of System Admin > Identity > Person.

Figure - COI Annual Disclosure > Disclosure Page > Reporter Panel – Contact Information Subpanel
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Table - Financial Entities > Reporter Tab > Reporter Panel > Contact Information Subpanel– Field Descriptions

Field

Description

Full Name

Name of the person who is logged into KC, and is reporting a financial interest in an entity.

User Name

The name with which the User is able to log in to the KC application (the User’s MSU Net ID).

Email Address

Logged-in User's work email address.

Office Phone

Logged-in User's work phone number.

Primary Title

Logged-in User's primary work title, or primary job title.

Directory Title

Logged-in User's work title used in the institution directory; job title as recorded in the employee directory
maintained by the HR department.

Home Unit

Automatically populated with the primary dept. code in the Person data record of the logged-in User.

School

The name of the institution where the logged-in User is employed, and/or the school within the institution
where the User works.

eRA Commons
User Name

Login for NIH researchers: 6-20 characters, letter/numbers, no special characters.

Fax

The fax number of the logged-in User.

Pager

The pager number of the logged-in User.

Mobile

The mobile number of the logged-in User.

Office Location

The primary office location of the logged-in User.

Secondary
Office Location

The secondary office location of the logged-in User.

Address Line 1

Line one of the primary work address of the logged-in User.

Address Line 2

Line two of the primary work address of the logged-in User.

Address Line 3

Line three of the primary work address of the logged-in User.

City

The city of the primary work address of the logged-in User.

County

The county of the primary work address of the logged-in User.

State

The State of the primary work address of the logged-in User.

Postal Code

The postal code of the primary work address of the logged-in User.

Country

The country of the primary work address of the logged-in User.

Unit Details
The Unit Details are populated from the Reporter’s Person record. Existing units may be added, deleted,
and the designated lead unit modified for use with the Financial Entities, but changes here will not
impact or update the Person record. One unit must be designated as the Reporter’s Lead Unit by clicking
one box in the Lead column.

Figure - COI Annual Disclosure > Disclosure Page > Reporter Panel> Unit Details Subpanel
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Table - Financial Entities > Reporter Tab > Reporter Panel > Unit Details Subpanel– Field Descriptions

Field

Description

Unit Name

Automatically populated with the name of the primary dept. in the Person data record of the logged-in User.

Unit Number

Automatically populated with the primary dept. code in the Person data record of the logged-in User

Lead

Checkbox to designate the Reporter's lead, or primary unit.

COI Training Information
The COI Training Information subpanel is used to maintain a record of the date and type of training that
was completed. The information is entered manually by the COI Administrator, and the information may
then be viewed by anyone with access to the disclosure.

Figure - Financial Entities > Reporter Tab > Reporter Panel > COI Training Information Subpanel – Example

Table - Financial Entities > Reporter Tab > Reporter Panel > COI Training Information Subpanel– Field Descriptions

Field

Description

COI Training
Completion Date

The calendar date that the Reporter completed the COI training tutorial.

COI Training Type

The format of the completed COI training (generally, online).

Screening Questionnaire – Annual Disclosure
The Screening Questionnaire allows Reporters who have no relationships with financial entities a quick
path to certification and submission of the disclosure. The question within the Screening Questionnaire
panel requires the Reporter to select a “Yes” or “No” response.
In the following example, a screening questionnaire has been deployed. The title COI Screening
Questionnaire displays in the subpanel header. Until the question is answered, the (Incomplete) status
will remain.

Figure - COI Annual Disclosures > Disclosure Page > Screening Questionnaire Panel - contents shown; screening questionnaire
incomplete
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To complete the screening questionnaire, expand the sub-panel by clicking the
toggle button
and then answer the question. Once the screening questionnaire has been successfully completed, the
title band will update to “(Complete)”

Figure - COI Annual Disclosures > Disclosure Page > Screening Questionnaire sub-panel - contents shown

Screening Questionnaire Business Rules: The screening question response by the Reporter is analyzed
by the system to determine whether the Reporter needs to define a financial entity or not. The system
performs the following check:


If the Reporter responds “No” to the screening question, they are not required to have an
existing financial entity or create a financial entity within the system. After responding to the
screening question they can go to the certification panel and submit the disclosure.



If the Reporter responds with “Yes” to the screening question, they are required to have an
existing financial entity or to create the financial entity prior to certifying and submitting the
disclosure. For Reporters who answer “Yes” to the screening question and don’t have an active
financial entity, the system displays the following message.

Maintenance note: Screening questionnaires are created and maintained through Questionnaire
Maintenance. To create a Screening Questionnaire, create a questionnaire with the appropriate
(Yes/No) type screening questions and define a usage of Module as COI Disclosure and a Module Sub
Item Code of Screening. The implementing school might choose to make the questionnaire mandatory
or optional through the Mandatory Column.

Figure - Maintenance/Questionnaire/COI Screening Questionnaire

Once the Screening Questionnaire has been deployed for COI, the same Screening Questions will
appear in all the COI disclosure types (such as project, travel, and annual). To create different
screening questionnaires for different disclosure types, a Kuali Rule Management System
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(KRMS) rule can be created to check the disclosure type. Once the KRMS rule has been created,
the rule can be connected to the Questionnaire usage through the Rule ID column in the
Questionnaire usage subpanel.

Figure - Maintenance/Questionnaire/COI Screening Questionnaire >Edit > Usage

Since the system does not enforce the rule that only questions with a “Yes/No” response type
should be defined within the Screening Questionnaire, for the screening question functionality to
work, implementing institutions must ensure that only questions with a “Yes/No” in the response
type are defined within the Screening Questionnaire.

Questionnaire – Annual Disclosure
If a questionnaire has been designated for this disclosure type, the title will appear in the Questionnaire
sub-panel. In the first example below, there are no questions to answer. (MSU has configured the COI
module this way.)
Maintenance note: Questionnaires are maintained for the Annual Disclosure by creating the questions,
creating a questionnaire, selecting Module: COI Disclosure and Sub-Module > Annual Disclosure, and
making the questionnaire Active.

Figure - COI Annual Disclosures > Disclosure Page > Questionnaire sub-panel- contents hidden

In the following example, a questionnaire has been designated. The title “Annual Disclosure” displays in
the subpanel header. Until the questions are answered, an (Incomplete) status will remain.

Figure - COI Annual Disclosures > Disclosure Page > Questionnaire sub-panel - contents shown; questionnaire incomplete

To fulfill the questionnaire requirement, expand the sub-panel by clicking the
then answer the questions.

toggle button and

Once the questionnaire has been successfully completed, the title band will update to (Complete).
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Figure - COI Annual Disclosures > Disclosure Page > Questionnaire sub-panel - contents shown; questionnaire complete

Disclosed Projects – Annual Disclosure
This panel will display all manual and event based disclosures (i.e., project and travel disclosures)
submitted by the Reporter that have been approved. Details for the each disclosed project including the
disclosure disposition and overall disclosure status are provided.

Disclosed Projects
The default display of the disclosed projects is by projects. All of the Reporter’s approved project and
travel events are displayed along with project and status details. For each project, all of the Reporter’s
financial entities along with the relationship to the project are displayed. To view the Reporter’s
financial entity relationships to each project click on the
button displayed beside each project in
the event column.

Figure - COI Annual Disclosures > Disclosure Page > Disclosed Projects

Table - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects)>Column layout

Field

Description

Event

Type of project (Travel Disclosure, Proposal, Protocol, IACUC Protocol, etc.)

Project Number

System populated project ID number from related proposal or award information.

Project Title

Title of project, as entered by user.

Disposition Status

Displays the "highest" degree of relationship that the identified project has with any of the
user's active financial entities (e.g., a status indicating the disclosure is under review or the
COI office needs to be contacted).

Disclosure Status

Displays the current review status of the project disclosure document (where the disclosure is
in the review process).

Once the
button is clicked, project-specific details, the completed questionnaire, and financial
entity relationships to the project will be displayed.
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Figure - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) > Financial Entities

Project Details
Project specific data such as Proposal Name, PI name, Sponsor, etc. is displayed in this subpanel. The
fields will differ based on the type of project displayed. The disposition status for the project as a whole
is also displayed on the header line.
For proposal events, the following details will be displayed with the proposal number:

Figure - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) >Proposal Development details

Table - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) >Proposal Development details

Field

Description

Proposal Title

Title of the Proposal Development document affiliated with the disclosure.

Sponsor

Name of the sponsor affiliated with the Proposal Development document.

Start Date

Project start date listed the Principle Investigator on the Proposal Development document.

End Date

Project end date listed the Principle Investigator on the Proposal Development document.

PI Name

Name of the Principle Investigator on the Proposal Development document.

For Institutional Proposal events, the following details will be displayed:

Figure - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) >Institutional Proposal details
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Table - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) >Institutional Proposal details

Field

Description

Proposal Title

Title of the Institutional Proposal document affiliated with the disclosure.

Sponsor

Name of the sponsor affiliated with the Institutional Proposal document.

Start Date

Project start date listed the Principle Investigator on the Institutional Proposal document.

End Date

Project end date listed the Principle Investigator on the Institutional Proposal document.

PI Name

Name of the Principle Investigator on the Institutional Proposal document.

For Award events the following details will be displayed:

Figure - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) > Award details

Table - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) > Award Number details

Field

Description

Title

Title of the Award affiliated with the disclosure.

Award Date

Date the Award was finalized.

For Manual (Travel) events, the following details will be displayed:

Figure - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) > Manual Award details

Table - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) > Manual (Travel Event) details

Field

Description

Event Title

User-entered name for the sponsored travel event.

Destination /
Location of Travel

Name of the location or destination of the travel event.

Sponsor Name

Name of the sponsor/entity providing funds for the travel event.
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Field

Description

Purpose of Travel

Reason for the travel event.

Amount of
reimbursement
received

Funding amount received from the sponsor for the travel event.

Start Date

Date the travel began.

End Date

Date the travel ended.

Financial Entities
All of the Reporter’s active financial entities and their relation to each project are displayed in this
subpanel. The relationship is expressed through a COI Disposition Code. The Reporter can update the
previously selected COI Disposition code value in the “Related to this Project?” column by selecting a
different value from the drop-down menu.

Figure - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects)>Project > Financial Entities

Table - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects) > Financial Entities Column layout

Field

Description

Review

The column that contains buttons to allow COI Reviewers and COI Administrators to view reported
information about the financial entity (view button) or view history about the financial entity (history
button).

Entity

The column that lists the name of the financial entity.

Related to
this Project?

The column that contains a drop-down list allowing the Reporter to select the financial entity’s
relationship to the project, lists the Reporter’s selection of the financial entity’s relationship, or lists
the COI Administrator’s determination of the financial entity’s relationship.

Comments

A text box containing comments provided about any financial entity in relation to the project.
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Adoption of Project-Financial Entity relatedness status with the highest numerical value as project and
disclosure status
The system uses the numeric code assigned to each COI Disposition Code to determine which
disposition code is displayed in the header panel for each project and the header panel for the
disclosure. The relationship with the highest code number is displayed in the header. Higher values were
assigned to the more “serious” relationships (i.e., those with possible or known conflict of interest) so
the most serious type of relationship is shown in project and disclosure headers.

COI Disposition Code

COI Disposition

100

In Progress

200

Not Related

210

No Conflict Exists

240

Disclosed Interests Managed

300

Under COI Office Review

303

Under COI Committee Review

305

Awaiting Additional Information

310

Potential Relationship

320

Relationship Identified

400

Disclosed Interests
Unmanageable

501

Not Reviewed

502

Reviewed Contact FCOI

As shown in the table above, the COI Disposition value for “Relationship Identified” (320) is higher than
“Potential Relationship” (310), which is higher than the COI Disposition value for “No Conflict Exists”
(210). Hence the system adopts the higher value status (Relationship Identified – 320) for the status at
the disclosure level.
The Status (COI Disposition Status) of the Disclosure on the header panel is derived from the project-toentity relationship statuses with the highest numerical value. See the table above.

Figure - COI Annual Disclosures > Disclosure Page > Header panel > Status
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Notes & Attachments – Annual Disclosure
The Notes & Attachments panel of the Disclosure page allows the User to add textual notes and attach
external files to a Disclosure document.

Figure - COI Annual Disclosures > Disclosure Page > Notes & Attachments panel

Notes
1. To create a note, enter a Note Topic (this field is required in order to create a note).
2. Write the note in the Note Text field provided (this field is also required in order to create a
note).
3. Indicate the type of note from the Note Type field – you can select from PI Entry, Reviewer
Comment, or COI Officer values. This is an optional field.
4. If the note pertains to one of your listed projects, you may select it from the drop-down list in
the Project column.
5. If the note pertains to one of your active financial entities, you may select it from the drop-down
list in the Financial Entity column.
6. The Restricted column is only active for the COI Administrator and Reviewers.
7. Click the Add button in the Action column to save this note entry.

Figure - COI Annual Disclosures > Disclosure Page > Notes subpanel entry area

Once added, the note will appear in the subpanel. You can edit the note topic and text by clicking the
edit button. Or you can delete the note by clicking the delete button.

Attachments

Figure - COI Annual Disclosures > Disclosure Page > Attachments subpanel entry area

1. To attach a document, select an Attachment Type from the drop-down list.
2. If desired, you may enter a contact name, email, and phone number in the fields provided.
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3. If the attachment pertains to a listed project, financial entity, or both, you may select one from
the drop down list.
4. Enter a comment in the text field, if desired.
5. A description of the attachment is required in the Description field.
6. Use the “Choose File” button to search for and select the document to upload.
7. Click the Add button to complete this attachment upload.
Once added, you can expand the subpanel to view, replace, or delete the attachment.

Figure - COI Annual Disclosures > Disclosure Page > Attachments subpanel with an attachment maintained

Table – COI Annual Disclosure > Disclosures Page > Notes & Attachments Panel > Field Descriptions

Field

Description

Notes Subpanel
Created By

User name and date and time stamp when the note was posted.

Updated By

User name and date and time stamp when the note was last updated.

Note Topic

Displays the topic of the note as entered by the author. Required field for saving a
note.

Note Text

Displays the text of the note entered by the author. Required field for saving a note.

Note Type

Displays the drop-down option selected by the author to identify whether the note
was entered by a PI, by a Reviewer, or by the COI office.

Project

Read-only field where the project title for the project in which the note is being
created is auto-populated.

Financial Entity

Displays the drop-down option selected by the author if he or she identified whether
the note was related to a reported financial entity.

Restricted?

Notes that are flagged as restricted by either a Reviewer or by COI Administrator are
not viewable by the Reporter, but are viewable to the COI Administrator and
Reviewers. Field displays "true" when note is restricted, and "false" when unrestricted.

Actions

Actions that are available on notes. On an approved disclosure, this field is empty,
because the approved disclosure is read-only.

Attachments Subpanel
<number>*

Sub-panel header displays to user the total number, in integer form, of the
attachments entered into all disclosed projects and reported entities.

Sort By

Drop-down field where user can sort all attachments to display by either description,
date of last update, who updated, or no sort at all.

Attachment Type

Read-only field that displays to the user the type of attachment: PI Submission,
Management Plan, or Other.
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Field

Description

Contact Name

Read-only field that displays to the user the name of the person who may be contacted
regarding the attached file.

Project

Read-only field that displays to the user the project to which the attached file pertains.

Financial Entity

Read-only field that displays to the user the entity to which the attached file pertains.

Uploaded By

Read-only field populated with the user name of the person who uploaded the
attached file.

Email

Read-only field that displays to the user the email address of the person who may be
contacted regarding the attached file.

Posted Timestamp

Read-only field populated with the time and date the file was originally attached.

Phone

Read-only field that displays to the user the phone number of the person who may be
contacted regarding the attached file.

Comments

Read-only field that displays to the user any comments related to the attachment.

Description

Read-only field that displays to the user the original description of the attachment.

File Name

Field is system-populated by the name of the attached file. Actions here are limited to
opening and viewing the attached file.

Certification – Annual Disclosure

Figure – COI Annual Disclosures > Disclosures Page > Certification sub-panel, hidden

The Certification panel displays a written statement regarding disclosure of significant financial interests
of the Reporter. It is provided for you to read and then acknowledge the reading by submitting a
certification. Once you have read the statement, check the box, and then click the submit button to
complete this disclosure.
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Figure - COI Annual Disclosures > Disclosures Page > Certification sub-panel, no yet certified

To acknowledge and submit your disclosure certification:
1. Click within the check box to acknowledge/certify.
A check mark appears within the check box to indicate your selection.
The following additional information appears under the certification statement text as a result of
the check selection action:
Your name, role (Reporter) and certification date are displayed.
Two action buttons appear: submit; and print.

2. Click the

button.

3. Click the OK button. The submit button is replaced by the current date (certification date).
NOTE: If you answered ‘yes’ to the screening questionnaire, then you must have at least one active
Financial Entity. If you do not have one entered in the system, you will be prompted to enter it
before your certification is completed.
Clicking the
button causes a browser save/print dialog box to pop up which allows you to
save an automatically generated PDF document.
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Disclosure Data Validation – Annual Disclosure
If you have not completed all the required actions in the disclosure, you may be presented with a
validation error, which appears at the top and bottom of the page. Details about the error can be found
within the Data Validation panel and in the specific panel where the error needs to be fixed.
Click the

button to display the Data Validation panel.

Click the Turn On Validation button to expand the Data Validation panel.

Figure -COI Annual Disclosure > Data Validation Panel

Click the

button in the Validation Errors subpanel to display the items to be fixed.

Use the fix button to navigate directly to the item.

Figure - COI Annual Disclosure > Data Validation sub-panel > validation error details
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Financial Entities
Overview
Before you start to use the Financial Entities functionality, it is important to have a basic understanding
of the context of its use and why it is important. In the sphere of Conflict of Interest, a Financial Entity
(FE) is a domestic or foreign, public or private, for-profit or not for-profit, business, organization, or
association; including but not limited to, a corporation, limited liability company, partnership, trust, or
proprietorship. At MSU, all faculty and academic staff, plus any person proposing, conducting or
reporting research, must disclose to MSU details about Financial Entities in which they have an interest,
which also relate to their research or other work at MSU. For more information about which FE interests
and relationships must be disclosed, please see information provided at coi.msu.edu.
In Kuali Coeus (KC) the Reporter provides details about their financial entities, and then manages their
Financial Entities lists by updating, deactivating, reactivating, etc. The Financial Entity records in KC are
linked to the Reporter’s disclosures in KC. Together, the FE records and disclosure records comprise a
Reporter’s Conflict of Interest disclosure.

Business Needs and Purpose
The Financial Entities screen is used to:


Create, revise, and deactivate information about entities outside of the university (“Financial
Entities”) with which Reporters have a personal financial relationship.



Review Financial Entities prior to preparing a disclosure, as the active entities are included in the
Reporter’s Conflict of Interest Disclosures. Disclosures are reviewed by appropriate institutional
administrators ensure compliance with federal, state, and local regulations.

Policy
Institutional policies generally require that officers, faculty, staff, and others acting on its behalf avoid
ethical, legal, financial, and other conflicts of interest and ensure that their activities and interests do
not conflict with their obligations to the institution. Disclosure of Financial Entities enables the
institution to determine if a financial interest creates a conflict of interest or the appearance of a conflict
of interest. The existence of a conflict or the appearance of one does not imply wrongdoing and does
not necessarily mean that a Researcher may not retain his or her financial interest and undertake the
affected research. Often, the institute can work with the Researcher to manage a conflict or appearance
of a conflict so that the research can continue in a way that minimizes the possibility of a bias and
preserves the objectivity of the research. Proper management depends on full and prompt disclosure.
MSU’s Conflict of Interest Policy is available and explained at coi.msu.edu.
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Roles and Responsibilities
The primary responsibilities for each actor in this procedure are:


Reporters are faculty and academic staff, as well as anyone listed as Key Personnel on research
proposals. Reporters are responsible for entering/selecting, submitting, and maintaining
financial entity information.



The COI Administrator is responsible for reviewing financial entity information submitted by the
Reporter, and communications with the Reporter regarding management and mitigation of
potential conflicts of interest.

The generic actor Reporter (view/edit) may refer to any of the following equivalent applicable job titles:


Principal Investigator, Research Staff, MSU Faculty/Academic Staff.

The generic actor COI Administrator (view) in this procedure may refer to any of the following
equivalent applicable job titles:


Financial Conflict of Interest Officer, COI Administrator/Staff, Assigned Reviewer.

Document Layout
The Financial Entities screen is comprised of three tabbed pages (Reporter, New Financial Entity, and My
Financial Entities), each with multiple subpanels for display, selection, and entry of information, and an
action button area.
Table - Financial Entities Screen - Major Components Overview

Major Document
Component

Summarized Description

Tabbed Pages

Pages that make up the document, which are accessible by clicking individual tabs.
These are groupings of functionally related information for the purpose of collection
and display. They are generally designed to be completed in left-to-right order.

Tabbed Page Panels

Multiple tabbed panels of each page containing data entry/selection/display fields
that are expanded or collapsed via hide/show buttons. Some panels contain
subpanels – the labels for which are highlighted in a darker shade of grey.

Action Buttons

Buttons that appear at the bottom, center of the document (regardless of page),
some of which are common to all E-docs, and some of which are unique to this
particular document.

NOTE: Financial Entities are not E-docs, thus there is no document header information because it does
not go through workflow like disclosures.
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Figure - Financial Entities Screen Components

Pages
The Financial Entities screen is comprised of three tabbed pages. Upon initial access, you are presented
with the Reporter, the New Financial Entity, and the My Financial Entities tabs with the ability to
navigate to any of the three tabbed pages without saving information first.

Figure - Financial Entities Screen – Three Tabbed Pages

Table - Financial Entities – Page Descriptions and Subtopic Links

Page

Brief Description

Reporter

Displays Reporter contact information and unit details based on the logged-in user. Additionally, you
have the ability to add unit details.

New Financial Entity

Displays entry & selection fields to specify details of the financial entity and the Reporter relationship
with the entity.

My Financial Entities

Displays a summarized view of information about all financial entities associated with you, the
Reporter, and options to take further action for each.
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Creating a New Financial Entity
Introduction
The New Financial Entity page is completed when you need to add a new entity for inclusion in a
disclosure. Entities may be added and updated at any time, but should always be reviewed for accuracy
prior to creating any disclosure.
Scope
This procedure covers:


Defining a new financial entity



Specifying relationship details

Navigation Path
Getting started – this quick system reference depicts how to access the start screen.
Create New
Researcher Tab > Conflict of Interest > COI Disclosures > Enter New/Changed Financial Entity
Access Existing
Researcher Tab > Conflict of Interest > Disclosure Information > View All My Financial Entities

Maintaining Financial Entities may involve any of the following three primary actions:


Add a New Financial Entity



Edit an existing Financial Entity



Activate a previously deactivated Financial Entity



Deactivate an existing, Active Financial Entity, or activate an Inactive Financial Entity

View History is an available option, but this is a view-only screen, not an action.
The following condensed and abbreviated quick reference instructions only provide task steps for
adding a new Financial Entity.

To complete the New Financial Entity subpanel:
1. Define the Entity: Make selections and entries into required fields for the Financial Entity, as well
as non-required fields as desired.


Entity Name: Type to enter.
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Type: Select an option from the drop-down menu list.



Status Code: Select either Active (default) or Inactive.



Public/Privately Held: Select either Public (default) or Private.



Address Line 1: Type numbers or letters.



City: Type the name of the city.



Country Code: Select from the list the name of the country of the entity’s address.



Postal Code: Enter the value (for example, a Zip code).



Describe your relationship with this entity: Type to enter text describing your
involvement with the entity.



What is the principle business activity of the entity?: Type to enter text describing the
entity’s primary business activity.



How is the entity related to your university responsibilities: Type to enter text indicating
how the entity’s area of business relates to your work at the University.

2. Define the Relationship Details: Make selections and entries in fields in the Relationship Details
subpanel as appropriate:


Each line must have a check in at least one box: None, Self, Family, or Jointly.



At least one line must have a check to indicate a relationship (Self, Family, and/or Jointly).



You may not check the box for None on the same line where you check Self, Family,
and/or Jointly.



For each line where you have checked Self, Family, and/or Jointly, you must enter text in
the Comment field for that line.

3. Upload Attachments Add an attachment to assist in the description of this entity and relationship.
This is not a requirement, but may be a local policy (i.e., college or department policy).
4. Click the

button.
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Process Flow

Financial Entities
COI Channel

My Financial Entities
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Financial Entity?

No
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New Financial Entity
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Add Unit?
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-View History

Inactive Entities
Actions:
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-Edit
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-View History

Submit to
save units

Figure - Financial Entity Completion Process Flow Chart Diagram

Workflow, Routing and Status
Financial Entities are not E-docs and, thus, do not route for review or change status based on document
completion or workflow approvals in the same way most KC E-docs (research proposals or annual COI
Disclosures) do. Financial Entities do not enter workflow. Financial Entities are separately maintained
records, which are associated to the Disclosure documents, where the Reporter must identify if there is
any relationship between their projects and their Financial Entities. COI Disclosure status relates to the
review and approval actions of the Disclosure containing Financial Entities. Submitted Disclosure
documents are reviewed and a disposition status is applied for that particular review. A Reporter may
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need to make adjustments in their relationship with a Financial Entity in order to resolve a perceived
conflict.

Subtopics
The subtopics that follow provide information about how to use each of the Financial Entity tabs, with
field descriptions in tables for each field and screen shot examples to demonstrate usage and depicting
example input.

Reporter

The Reporter tab is the first tabbed page. It contains one panel, Reporter, comprised of two subpanels –
Contact Information and Unit Details.
The Reporter’s information comes from the Person data associated with the logged in user. If any of the
contact details are incorrect, they can be updated in KC by a user with the appropriate roles via the
navigation path: System Admin > Identity > Person. Most KC implementations update/maintain this
Person data table with a regularly scheduled HR Data feed. The Reporter must have one unit designated
as a Lead. Units may be added, deleted, and designated as lead for use with the Financial Entities, but
changes here will not impact or update the Person record.

Figure - Financial Entities > Reporter Page > Reporter Panel – Example
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Table - Financial Entities > Reporter Tab > Reporter Panel Descriptions

Reporter Panel

Description

Contact Information

Display-only identifying details of the Reporter.
Automatically populated from the KC Person record associated with the logged-in user. Changes to the
contact information in KC are made in via the System Admin > Identity > Person.

Unit Details

Automatically populated with the primary department code in the Person data record associated with
the Reporter. Additional units may be added. At least one unit must be maintained and designated as
the Lead.

Contact Information
The Reporter’s Contact Information is display only, populated from the Person data associated with the
logged in user. If they are incorrect, they can be updated in KC by a user with the appropriate roles via
the navigation path: System Admin > Identity > Person.

Figure - Financial Entities > Reporter Page > Reporter Panel > Contact Information Subpanel – Example

Table – Financial Entities > Reporter Tab > Reporter Panel > Contact Information Subpanel – Field Descriptions

Field

Description

Full Name

Name of the person who is logged into KC and is reporting a financial interest in an entity.

User Name

The name with which the User is able to log in to the KC application.

Email Address

Logged-in User's work email address.

Office Phone

Logged-in User's work phone number.

Primary Title

Logged-in User's primary work title, or primary job title.

Directory Title

Logged-in User's work title used in the institution directory; job title as recorded in the employee directory
maintained by the HR department.

Home Unit

Automatically populated with the primary dept. code in the Person data record of the logged-in User.

School

The name of the institution where the logged-in User is employed, and/or the school within the institution
where the User works.

eRA Commons
User Name

Login for NIH researchers: 6-20 characters, letter/numbers, no special characters.
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Field

Description

Fax

The fax number of the logged-in User.

Pager

The pager number of the logged-in User.

Mobile

The mobile number of the logged-in User.

Office Location

The primary office location of the logged-in User.

Secondary
Office Location

The secondary office location of the logged-in User.

Address Line 1

Line one of the primary work address of the logged-in User.

Address Line 2

Line two of the primary work address of the logged-in User.

Address Line 3

Line three of the primary work address of the logged-in User.

City

The city of the primary work address of the logged-in User.

County

The county of the primary work address of the logged-in User.

State

The State of the primary work address of the logged-in User.

Postal Code

The postal code of the primary work address of the logged-in User.

Country

The country of the primary work address of the logged-in User.

Unit Details
The Unit Details are populated from the Reporter’s Person record. Existing units may be added, deleted,
and the designated lead unit modified for use with the Financial Entities, but changes here will not
impact or update the Person record.

Figure – Financial Entities > Reporter Tab > Reporter Panel > Unit Details Subpanel – Example

Table – Financial Entities > Reporter Tab > Reporter Panel > Unit Details Subpanel – Field Descriptions

Field

Description

Unit Name

Name of the Unit of a User’s institution affiliation (e.g., department).

Unit Number

Populated by the selection made from the Unit Name Lookup; Displays hyphenated descriptor of parent unitschool/dept.

Lead

Checkbox to designate the Reporter's lead, or primary unit.
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New Financial Entity Tab

The New Financial Entity tab has two panels:


New Financial Entity: used to define the New Financial Entity and Relationship Detail
information.



Attachments: used to upload and retain documents related to this entity.

New Financial Entity Panel
The New Financial Entity page is where the Reporter enters details about any new significant financial
interests (SFIs) and defines their relationship with that entity. Reporters must disclose any new SFIs
within 30 days following the date on which the significant Financial Interest is acquired or arises.
In this subpanel, you can disclose new entities and upload relevant attachments. Once the entity is
submitted, it can be viewed and updated on the My Financial Entities tab.

Figure – Financial Entities > New Financial Entity Tab > Financial Entity Subpanel – Layout (Collapsed)

Table – Financial Entities > New Financial Entity Tab > Financial Entity Subpanel Descriptions

New Financial
Entity Panel

Description

Financial Entity

The name, type, associated sponsor, contact information, basic relationship description.

Relationship Details

Ownership / relationship details

In the Financial Entity subpanel, you will provide some specific information about the new entry. See the
table below descriptions of the fields in this subpanel.
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Figure – Financial Entities > New Financial Entity Tab > Financial Entity Subpanel

Table – Financial Entities > New Financial Entity Tab > Financial Entity Subpanel > Field Descriptions

Field

Description

Entity Name

Name of the entity in which the logged-in User or immediate family member holds an
interest.

Type

User selects from drop-down menu the best description of the type of entity being
reported.

Sponsor Code

A six-digit identification number uniquely identifying an organization or agency that
provides support for sponsored projects (optional). This search function can be used
when the Reporter’s financial entity happens to be listed on the Institution’s
established list of sponsors. Selecting a name from the Sponsor list will populate
details into the Financial Entity panel. But usually, the Reporter will enter the name of
the entity in the Entity Name field.

Related To Organization Flag

If box is checked, it indicates that the entity is related to the User's institution.
(optional)

Status Code

User selects "Active" or "Inactive" to describe whether his or her interest in the entity
is current (Active), or previously held (Inactive).

Public/Privately held

User selects whether the entity is a private or a publically-held entity.

Address Line 1

User enters first line of entity's street address.

Does this entity sponsor any of
your research? / Yes

User selects "Yes" radio button to disclose that the entity provides funding for any part
of the User's research.

Does this entity sponsor any of
your research? / No

User selects "No" radio button to disclose that the entity does not provide funding for
any part of the User's research.

Address Line 2

User enters second line of entity's street address, if needed.

Address Line 3

User enters third line of entity's street address, if needed.

City

User enters the city where the entity is located.

State

User enters the state where the entity is located.

Describe your relationship
with this entity:

User enters a free-form description of his/her relationship to the entity

Country Code

User selects the country where the entity is located.

Postal Code

User inputs the postal code for the entity's location.

Web Site 1

User types the primary website url for the entity.
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Field

Description

Web Site 2

User types any applicable secondary website url for the entity.

What is the principle business
activity of the entity?

User types description of the entity’s area of business.

How is the entity related to
your university
responsibilities?

User types explanation of how the entity’s area of business is related to his/her work
at MSU

Relationship Details
The Relationship Details subpanel is a configurable grid where the institution’s system administrators
can determine what relationship types should be reported (None, Self, Family, or Jointly, etc.), define
categories to group the detailed queries within, and customize how the Reporter answers each item
(checkbox or custom selection list).


Relationship Type Columns: These columns provide the ability for the Reporter to answer for
different persons for whom the entity relationship applies. Example data includes None, Self,
Family, and Jointly. These types are configurable by implementing institution via Maintenance >
Compliance-Conflict of Interest > Entity Relationship Type.



Entity Data Groups: This feature allows the queries to be grouped by topic. Example data
includes Own Business or Stock, Indebtedness to Entity, Unvalued Stock Options, etc. These
categories are configurable via Maintenance > Compliance-Conflict of Interest > Entity Data
Groups.



Entity Data Objects Matrix: The data groups can contain one or many objects where the
Reporter can supply answers that describe the relationship to the entity. These objects can use
check boxes or drop-down menus and are configured by implementing institution via
Maintenance > Compliance-Conflict of Interest > Entity Data Matrix.
Comment Fields: Each data object line item includes a text comment field that can be used to
describe the relationship (up to 300 characters). Click within the text box (or press the tab
key from a previous field) to reposition the cursor so that it is within the field, and then type (or
paste from virtual clipboard) to enter text in the box as necessary to provide the appropriate
information.
You may click the expand text
icon to display a larger window to type in. Click the continue
button to close the window. Click the green arrow icon to read it in its entirety in the larger
pop-up window. Click the close button to close the window.
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Figure - Financial Entities > New Financial Entity Tab > Relationship Details subpanel

Table - Financial Entities > New Financial Entity Tab > Relationship Details Subpanel – Field Descriptions

Field

Description

Column Value

User selects one of four checkboxes that best describes who held the interest described on
each line item, over the last calendar year: "None," "Self," "Family," or "Jointly."
"Family" is selected if a member of the User's immediate family holds the interest in the entity.
"Jointly" is selected when both the User and someone in the User's immediate family both
hold the interest in the entity.

Relationship Type

User selects one of four checkboxes that best describes who held the interest described on
each line item, over the last calendar year: "None," "Self," "Family," or "Jointly."
"Family" is selected if a member of the User's immediate family holds the interest in the entity.
"Jointly" is selected when both the User and someone in the User's immediate family both
hold the interest in the entity.

Comment

User enters any additional information (up to 300 characters) pertaining to the interest in the
entity held by either by himself/herself, or a family member, or jointly. If a User has checked
Self, Family, or Jointly in a row, then there must be an entry in the Comment field for that row.

Attachments
The Attachments panel can be used to upload and maintain documents that are related to this financial
entity. Attachments are not required to save or submit a financial entity. Once added, the attachments
appear in a list below the Add row.

Figure - Financial Entities > New Financial Entity Tab > Attachments Panel
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Table - Financial Entities > New Financial Entity Page > Attachments Panel> Field Descriptions

Field

Description

Posted Timestamp

System-generated, read-only entry of the date and time that an attachment was affixed to the
financial entity record.

Uploaded by

System-generated, read-only entry of the logged-in user who uploaded the attachment.

Contact Name

User may enter the name of any relevant contact person associated with the attachment. Once
document is saved, field becomes read-only.

Email

User enters the email address for any contact person associated with this attachment. Once
document is saved, field becomes read-only.

Description

User enters a description of the attachment. Required field for saving document. Once
document is saved, field becomes read-only.

File Name

User browses accessible directories and selects the document to attach to the present financial
entity record. The "File Name" field auto-populates with the document's file name. Required
field for saving document. Once document is saved, field becomes read-only.

Financial Entity Actions
There are three (3) action buttons on the bottom of the New Financial Entity page: Submit, Refresh, and
Cancel. Financial Entities do not enter workflow, but will be added to the My Financial Entities list and
included in the Reporter’s disclosure documents.

Submit a New Financial Entity
To save and complete a Financial Entity record, click the Submit button. The entity will now appear on
the My Financial Entities tab.
Refresh a New Financial Entity
To clear all data entered in the New Financial Entity page, click Refresh. Note: all entered data and
attachments in this entity will be deleted.
Cancel a New Financial Entity
To cancel the process of adding an entity, click the Cancel button. You will be asked if you are sure you
wish to cancel. Click “No” to be returned to the New Financial Entity tab and complete your entry. Click
“Yes” to discard any entered data and be returned to the Researcher channel. (Note: to Inactivate a
Financial Entity that was previously submitted, you must access the My Financial Entities tab (see
below).
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My Financial Entities Tab

The My Financial Entities tab consists of one panel for Financial Entities and displays all of the Reporter’s
financial entities in two subpanels; the top subpanel lists Active Entities and below that, the Inactive
Entities. This tab is where Reporters may view and update their existing financial entities. All Active
entities are included in disclosures. Financial Entities are never deleted: instead, they may be changed to
Inactive status so they do not appear in future disclosures.

Financial Entities Panel
Once entities are created and submitted (saved) they are managed in this page by a set of action
buttons. Active Entity actions are: view, edit, deactivate, and view history. Inactive Entity actions are:
view, edit, activate, and view history.

Figure - Financial Entities > My Financial Entities Tab > Financial Entities Panel

Table - Financial Entities > My Financial Entities Tab > Financial Entities Panel Descriptions

Action

Description

Active Entities
Name (no field name label)

Read-only display of entity name as entered by User.

Sponsor (no field name label)

Read-only display of sponsor name, if a sponsor record was selected by the User when
the entity was entered or last edited.

Last update (no field name
label)

Read-only display of the date and time the entity was entered or last edited by the
User.

Inactive Entities
Name (no field name label)

Read-only display of entity name as entered by User.

Sponsor (no field name label)

Read-only display of sponsor name, if a sponsor record had been selected by the User
when the entity was entered or last edited.

Last update (no field name
label)

Read-only display of the date and time the entity was deactivated by the User.
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Active Entities
Active financial entities are included in disclosures: the Reporter must disclose if the entity is related to
their projects. The Reporter should review and update all of their entities prior to preparing a disclosure.
If the Reporter’s connection to the entity is no longer valid, the entity status should be changed to
Inactive.

Figure - Financial Entities > My Financial Entities Tab > Financial Entities Panel > Active Entities Subpanel

Inactive Entities
Once a financial entity is created, it will always remain in the Reporter’s My Financial Entities list and
cannot be deleted. Instead of deleting, the Reporter clicks the Deactivate button for the entity: this
marks the entity status as “Inactive” and moves the entity to the Inactive Entities subpanel. Should the
relationship resume, the Reporter can click the Activate button to return the status back to “Active”,
rather than creating a new entity. When changing from inactive to active, the Reporter should carefully
review the record and update the relationship details appropriately.

Figure - Financial Entities > My Financial Entities Tab > Financial Entities Panel > Inactive Entities Subpanel
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Disclosure Actions
The COI Administrator is responsible for reviewing and potentially approving all submitted disclosures.
The COI Administrator may assign a disclosure to other persons for further review prior to approval.

Disclosure Actions Tab
The Disclosure Actions tab is available only to COI Administrators and any assigned Reviewer.
Additionally, it is available only when a disclosure is in Routed for Review status. After a disclosure is
approved, the Disclosure Actions tab does not appear for viewing. Available disclosure actions are
identical for all disclosure types. The Disclosure Actions tab contains three sub-panels: Reviewer Actions,
Administrator Actions, and Data Validation; however, a Reviewer is only presented with Reviewer
Actions and Data Validation panels. The available actions in each sub-panel are described below.
Locate a disclosure for review and open it.

Figure - Conflict of Interest > Disclosure Search result line example

The COI Administrator has access to the Disclosure Actions tab in the disclosure record. Click on the
Disclosure Actions tab to review the contents.

Figure - COI > Disclosure >Disclosure Tab enabled for Administrator or Assigned reviewer

For COI Administrators, the Disclosure Actions tab contains three (3) sub-panels for Reviewer Actions,
Administrator Actions, and Data Validation.
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Figure - COI > Disclosure >Disclosure Actions Tab example

Reviewer Actions
The Reviewer Actions panel is intended for Reviewers assigned to the disclosure to provide their review.
The COI Administrator also has access to this panel and can view Reviewer notes, attachments, and
recommended action.
In order for Reviewers to access disclosures assigned to them, Reviewers need to click on the Review
Disclosures Assigned to Me link on the Researcher tab.

Figure - KC Researcher tab > Conflict of Interest > Review Disclosures Assigned to Me

From the results returned on clicking the Review Disclosures Assigned to Me link, Reviewers open the
disclosure assigned to them for review, go to Disclosure Actions tab and open the Reviewer Actions
panel. This panel allows Reviewers to add notes, attachments, and provide recommended action for the
disclosure assigned to them.
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Figure - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions

Notes
The Notes subpanel allows the Reviewer to add one or more notes related to the disclosure review.
Reviewers can enter a note topic, add a note description, indicate the type of note, select project and
financial entity the note relates to, and choose to make the note private or public using the restricted
checkbox.
Accessing notes added by Reviewers: Assigned reviewers have view access to other Reviewer’s
restricted and un-restricted notes for that disclosure. COI Administrators have view, edit, and delete
rights to reviewer’s notes.

Figure - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions >Notes

Kuali Coeus 5.2.1 User Guide—Conflict of Interest Section

44

Table - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions > Notes column layout

Field

Description

Created By

User name and date and time stamp when the note was posted.

Updated By

User name and date and time stamp when the note was last updated.

Note Topic

Displays the topic of the note as entered by the author. Required field for saving a note.

Note Text

Displays the text of the note entered by the author. Required field for saving a note.

Note Type

Displays the drop-down option selected by the author to identify whether the note was entered
by a PI, by a Reviewer, or by the COI office.

Project

Read-only field where the project title for the project in which the note is being created is autopopulated.

Financial Entity

Displays the drop-down option selected by the author if he or she identified whether the note was
related to a reported financial entity.

Restricted?

Notes that are flagged as restricted by either a Reviewer or by COI Administrator are not viewable
by the Reporter, but are viewable to COI Administrators and Reviewers. Field displays "true" when
note is restricted, and "false" when unrestricted.

Actions

Actions that are available on notes. On a master disclosure, this field is empty, because the master
disclosure is read-only.

New Attachment
The New Attachment subpanel allows the Reviewer to attach files to the disclosure. For each
attachment, the Reviewer must provide the attachment type and a description.

Figure - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions >New Attachment

Table - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions >New Attachment fields

Field

Description

Attachment Type

Drop-down field where user can sort all attachments to display by either description, date of last
update, who updated, or no sort at all.

Contact Name

User views read-only information on every document attached to his or her Annual Disclosure,
and can also view the attached document.
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Field

Description

Uploaded By

Read-only field that displays to the user the type of attachment: PI Submission, Management
Plan, or Other.

Posted Timestamp

Read-only field that displays to the user the name of the person who may be contacted
regarding the attached file.

Comments

Read-only field that displays to the user the project to which the attached file pertains.

File Name

Read-only field that displays to the user the entity to which the attached file pertains.

Project

Read-only field populated with the user name of the person who uploaded the attached file.

Email

Read-only field that displays to the user the email address of the person who may be contacted
regarding the attached file.

Phone

Read-only field populated with the time and date the file was originally attached.

Description

Read-only field that displays to the user the phone number of the person who may be contacted
regarding the attached file.

Financial Entity

Read-only field that displays to the user any comments related to the attachment.

Attached Items
Once an attachment is added to the disclosure, the attachment appears within the Attached Items
subpanel. This subpanel shows details of the attachments added to the disclosure upon clicking the
button. In addition, it allows sorting attachments by Description, Last Updated By, and Last
Updated. This is a useful feature when there are multiple attachments.
Accessing attachments added by Reviewers: Assigned Reviewers have view access to other Revieweradded attachments. COI Administrators have view, edit, and delete rights to Reviewer-added
attachments.

Figure - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions > Attached Items

Kuali Coeus 5.2.1 User Guide—Conflict of Interest Section

46

Complete Review
Once the Reviewer has completed review of the disclosure, the Complete Review subpanel allows the
Reviewer to recommend an action for the disclosure. Providing a recommended action within the
Complete Review subpanel and clicking on submit completes the lifecycle of the disclosure review. A
Reviewer can view recommended actions of other Reviewers who have completed their review.
Once the Reviewer has completed their review, the disclosure is no longer accessible to the
Reviewer through the Review Disclosures Assigned to Me link on the KC landing page.

Figure - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions > Complete Review

Table - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions > Complete Review column layout

Field

Description

Full Name

The full name of the Reviewer. It is automatically populated by the system when reviewers are
assigned to a disclosure.

Reviewer Type

The Reviewer Type is a selection made by the COI Administrator when Reviewers are first
assigned to a disclosure. When Reviewers access the Complete Review subpanel, the system
automatically displays the Reviewer Type to the reviewer.

Lead Unit

This field displays the lead unit for the Reviewer. It is automatically populated by the system.

Date Assigned

This field displays the date the Reviewer was assigned to the disclosure.

Recommended
Action

The Recommended Action selection allows the Reviewer to communicate to the Administrator or
COI office what action they recommend for the disclosure.

Administrator as proxy reviewer: COI Administrator can use the Complete Review subpanel to view
actions recommended by other assigned Reviewers and also provide a recommended action on behalf
of a Reviewer.

Figure - COI Annual Disclosures > Disclosure Actions Page > Reviewer Actions > Complete Review – Administrator as proxy
reviewer
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Administrator Action
The Administrator Actions panel of the Disclosure Actions page allows a COI Administrator to assign
Reviewers to the disclosure, override the Project-to-Entity relatedness status (COI Disposition Status) set
by the Reporter and set the appropriate disclosure and review status for the disclosure.

Figure - COI Annual Disclosures > Disclosure Actions Page > Administrator Actions

Add Reviewers Action
The Add Reviewers Action panel allows the Administrator to assign a Reviewer Type and establish the
person as a Reviewer for the disclosure. Once added, the assigned Reviewer appears as a numbered line
item in the Add Reviewer Action subpanel. Multiple Reviewers can be assigned to the disclosure through
the Add action. Once Reviewers have been added, the Administrator is provided an option to delete the
Reviewer assigned to the disclosure. Reviewers assigned to the disclosure can access the disclosure
through the View All My Disclosures link on the Researcher tab.

Figure - COI Annual Disclosures > Disclosure Actions Page > Administrator Actions > Add Reviewer Action

Table - COI > Disclosure Document > Disclosure Actions Page > Add Reviewer Actions Subpanel

Field

Description

User Name

The NetID of the Reviewer added to review a Disclosure. It is automatically populated by the system
when Reviewers are assigned to a disclosure.

Full Name

The full name of the Reviewer added to review a Disclosure. It is automatically populated by the
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Field

Description
system when Reviewers are assigned to a disclosure.

Reviewer Type

The Reviewer Type is a selection made by the COI Administrator when Reviewers are first assigned
to a disclosure.

Lead Unit

The lead unit for the Reviewer. It is automatically populated by the system when Reviewers are
assigned to a disclosure.

Date Assigned

The date the Reviewer was assigned to the disclosure.

Note about statuses: Once Reviewers are assigned to a disclosure, the system automatically
sets the COI Review Status to Assigned To Reviewer. The system changes the status to Assigned
Review Complete once all assigned reviewers have completed their reviews. The COI review
status is displayed on the document header.

Figure - COI Annual Disclosures > Header panel > Review Status

Review Status
The Review Status subpanel allows the COI Administrator to set the COI Review Status or override the
COI Review status set by the system. The COI Review Status indicates the status of the review and also
provides information about the stage of the disclosure lifecycle.
The Review Status subpanel is dynamically displayed or hidden based on what stage of the review
lifecycle the disclosure is in. When Reviewers are not yet assigned, the Review Status subpanel is
displayed. Once Reviewers are assigned to the disclosure, the Review Status subpanel is no longer
visible. It becomes visible either when all Reviewers have completed their review or if Reviewers are
deleted through the Add Reviewers Action subpanel.

Figure - COI Annual Disclosures > Disclosure Actions Page > Administrator Actions > Review Status

Table - COI Annual Disclosures > Disclosure Actions Page > Administrator Actions > Review Status field descriptions

Field
Review Status

Description
A drop-down list that allows the COI Administrator to indicate the status of a
Disclosure in the review process.

Once the COI Review Status has been set, it is displayed in the header of the disclosure document.
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Approval Action
The Approval Action subpanel allows the Administrator to set the overall status of a disclosure. Based on
the project-to-entity relationships for the various projects within the annual disclosure, the system
dynamically presents either an Approve or a Disapprove option to the COI Administrator.
Disapprove
Implementing institutions can control which values of project-to-entity relatedness displays the
Disapprove action. COI Disposition values within the COI Disposition Code maintenance table with a COI
Disclosure Status Code of 4 are the only values that will trigger the system to show a Disapprove button
in the Approval Actions panel.

Figure - KC Maintenance > Compliance – Conflict of Interest > COI Disposition Code – COI Disclosure Status Code

In the KC COI out of the box application, the COI Dispositions of Unresolved and Disclosed Interests
Unmanageable are the only statuses set up to trigger a disapprove action.
Approve: If none of the project-to-entity relatedness codes (COI Disposition codes) have a COI
Disclosure Status Code of 4, the system displays the Approve button.

Figure - COI Annual Disclosures > Disclosure Actions Page > Administrator Actions > Approval Action – Approve button

Once the COI Administrator performs approve or disapprove action, the disclosure status appears on
the header of the disclosure document. Note that approved disclosures have Review Completed
disclosure status.

Figure - COI Annual Disclosures > Header panel > Disclosure Status

If during the approval of the annual disclosure the Reporter has any submitted project or travel
disclosures that have not been approved, the system generates a warning message to the COI
Administrator in the Approval Action panel. The message instructs the COI Administrator to
approve the submitted disclosures prior to approving the annual disclosure.
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Figure - COI Annual Disclosures > Disclosure Actions Page > Administrator Actions > Approval Action – warning for unresolved
event disclosures.

Data Validation
The Data Validation sub-panel assists the COI Administrator in review management of the disclosure. If a
required item is not present, the validation sub-panel is presented with an error message describing the
requirement.
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Access to Disclosures
The system allows various users (Reporters, COI Administrators, and Reviewers) access to the Reporter’s
disclosures. Reporters may access only their own disclosures. Disclosure Reviewers are allowed to access
disclosures assigned to them. Users with Administrator privileges can access all of the Reporter’s
disclosures that fall under their jurisdiction based on the unit the Administrator belongs to. COI
Administrators have access to all disclosures and can assign Reviewers for disclosures, as well as
approve/disapprove disclosures. In this section, the following user-driven disclosure look-ups will be
covered.
 Disclosure look-ups for Reporters
 Disclosure look-ups for Reviewers
 Disclosure look-up for Disclosure Reviewers
 Disclosure look-up for Disclosure List Viewer
 Disclosure look-ups for Administrators

Disclosure Lookups for Reporters
1. View All My Disclosures: The Reporter can access all of their own disclosures at any point in
time through the View All My Disclosures lookup on the Researcher tab.


To access this lookup navigate to Researcher > Disclosure Information > View All My
Disclosures

Figure - Researcher/Conflict of Interest/ Disclosure Information / View All My Disclosures



Click on the View All My Disclosures link. Various search parameters are provided to
refine the search results. Only the signed-in Reporter’s disclosures will be visible to the
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Reporter. The Actions column in the search results provides an “open” action for the
Reporter to open the disclosure and take the appropriate action.

Figure - Researcher/Conflict of Interest/ Disclosure Information/ View All My Disclosures > Search

Disclosure Lookups for Reviewers
There are a number of lookups provided for users with Reviewer privileges. These lookups can be
accessed through both the Unit and Central Admin tabs from the KC Landing Page.

Figure - Unit/Central Admin

The look-ups are available within the Pre-Submission Compliance channel.
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Click on any of the search icons found in the Conflict of Interest list. The search
parameters that correspond to the selected search type appear. They are used to refine
the search results. Only disclosures assigned to the Reviewer’s unit hierarchy will be
displayed. The Actions column in the search results provides an “open” action for the
Reviewer to open the disclosure and perform the review. A Reviewer cannot provide a
review recommendation.

NOTE: For a more detailed review of each individual link, please see the Disclosure Lookups for
Administrators found on page 54.

Disclosure Lookups for Disclosure Reviewers
1. Review Disclosures Assigned to Me: The Disclosure Reviewer can access all disclosures
assigned to them for review through the Review Disclosures Assigned to Me lookup on the
Researcher tab.


To access this lookup, navigate to Researcher > Conflict of Interest > Disclosure Review >
Review Disclosures Assigned to Me.
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Figure – Researcher / Conflict of Interest / Disclosure Review / Review Disclosures Assigned To Me



Click on the Review Disclosures Assigned to Me link. Various search parameters are
provided to refine the search results. Only disclosures assigned to the Reviewer will be
displayed. The Actions column in the search results provides an “open” action for the
Reviewer to open the disclosure and perform the review. Once the Reviewer has
completed the review and provided a recommended action, the system removes the
disclosure from the Reviewer’s queue.

Figure - Researcher / Conflict of Interest / Disclosure Review / Review Disclosures Assigned to Me

Disclosure Lookups for Administrators / Disclosure List Viewers
There are a number of lookups provided for users with administrative privileges – the COI Administrator
will likely use this functionality the most. Also, OSP/CGA staff (the Disclosure List Viewers) have
permission for the Disclosures link, but there will NOT be an Open link for them to view the details of a
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disclosure. These lookups can be accessed through both the Unit and Central Admin tabs from the KC
Landing Page.

Figure - Unit/Central Admin

The look-ups are available within the Pre-Submission Compliance channel.

Figure - Central Admin / Pre-Submission Compliance

1. Disclosure: The Administrator can access all disclosure details through the Disclosure lookup.
The Disclosure List Viewer will only be able to view the disclosure list. This role will mostly
be interested in whether a disclosure has Financial Entities and the COI Training Completion
Date.


To access this lookup, navigate to Central Admin > Pre-Submission Compliance >
Disclosure.
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Figure - Central Admin / Pre-Submission Compliance / Disclosures



Click on the lookup icon to the right of Disclosures to access disclosures. Various search
parameters are provided to refine the search results. The Actions column in the search
results provides an “open” action for the COI Administrator to open the disclosure and
process it.
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Figure - Central Admin/Pre-Submission Compliance/Disclosure Lookup

2. Project Disclosures: The COI Administrator can access all project disclosures through the
Project Disclosures look-up. Annual disclosures are not considered as project disclosures.


To access this lookup navigate to Central Admin > Pre-Submission Compliance > Project
Disclosures.
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Figure - Central Admin / Pre-Submission Compliance / Project Disclosures



Click on the look-up icon to the right of Project Disclosures to access the disclosures.
Various search parameters are provided to refine the search results. The Actions column
in the search results provides an “open” action for the COI Administrator to open the
disclosure and process it.

Figure - Central Admin / Pre-Submission Compliance / Project Disclosures Lookup
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3. Travel Disclosures: The administrator can access all disclosures associated with travel
generated events through the Travel Disclosures look-up.


To access this lookup navigate to Central Admin > Pre-Submission Compliance > Travel
Disclosures.

Figure -Central Admin / Pre-Submission Compliance / Travel Disclosures



Click on the look-up icon to right of Travel Disclosures to access them. Various search
parameters are provided to refine the search results. The Actions column in the search
results provides an “open” action for the COI Administrator to open the disclosure and
process it.

Figure - Central Admin/Pre-Submission Compliance/Travel Disclosure Lookup
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4. Submitted Disclosures: The COI Administrator can access all submitted disclosures through
the Submitted Disclosures look-up.


To access this lookup navigate to Central Admin > Pre-Submission Compliance >
Submitted Disclosures.

Figure - Central Admin / Pre-Submission Compliance / Submitted Disclosures



Click on the look-up icon to the right of Submitted Disclosures to access the disclosures,
which have been submitted to the COI office. Various search parameters are provided to
refine the search results. The Actions column in the search results provides an “open”
action for the COI Administrator to open the disclosure and process it.
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Figure - Central Admin / Pre-Submission Compliance / Submitted Disclosures Lookup

5. Annual Disclosures: The COI Administrator can access all of the Reporter’s annual
disclosures through the Annual Disclosures look-up.


To access this lookup navigate to Central Admin > Pre-Submission Compliance > Annual
Disclosures.

Figure - Central Admin / Pre-Submission Compliance / Annual Disclosures
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Click on the look-up icon to the right of Annual Disclosures to access the Reporter’s
annual disclosures. Various search parameters are provided to refine the search results.
The Actions column in the search results provides an “open” action for the COI
Administrator to open the disclosure and process it.

Figure - Central Admin / Pre-Submission Compliance / Annual Disclosures Lookup

6. Disclosures In Progress: The COI Administrator can access all of the Reporter’s in progress
disclosures through the Disclosures In Progress look-up.


To access this lookup navigate to Central Admin > Pre-Submission Compliance >
Disclosures In Progress.
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Figure 1 Central Admin / Pre-Submission Compliance / Disclosures In Progress



Click on the look-up icon to the right of Disclosures In Progress to access the Reporter’s
disclosures that have a status of In Progress. Various search parameters are provided to
refine the search results. The Actions column in the search results provides an “open”
action for the COI Administrator to open the disclosure and process it.

Figure - Central Admin / Pre-Submission Compliance / Disclosures In Progress Lookup

Disclosures Under Review: This lookup displays disclosures that have been submitted for review by
Reporters. This lookup is used by the COI Administrator to manage disclosures that require review and
action by the COI office: it serves as their “IN” box. The page segregates submitted disclosures in various
stages of review into three distinct categories – Open Reviews, Pending Reviews, and Work in Progress
Reviews. In addition, it separates disclosures with financial entities from those without entities. A quick
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approve option is provided to the COI Administrator for disclosures which do not have any financial
entities. The following chart indicates in which panel a disclosure will appear based on its Review Status.
Note that disclosures with Disclosure Status “Review Complete” do not appear on this page at all.

Review Status Code

Review Status

Sort to Panel:

1

In Progress

(do not display)

2

Submitted For Review

Pending Reviews

3

Assigned To Reviewer

Work in Progress Reviews

4

Assigned Review Complete

Open Reviews

5

Review Complete

Open Reviews

6

Received in COI Office

Open Reviews

7

Awaiting Additional Information

Open Reviews

8

Under Review by COI Reviewer

Work in Progress Reviews



To access this lookup navigate to Central Admin > Pre-Submission Compliance >
Disclosures Under Review.

Figure - Central Admin / Pre-Submission Compliance / Disclosures Under Review



Click on the lookup icon to the right of Disclosures Under Review to access the
Disclosures Under Review page.

Kuali Coeus 5.2.1 User Guide—Conflict of Interest Section

65

Figure - Central Admin / Pre-Submission Compliance / Disclosures Under Reviews

 Open Reviews: The Open Reviews panel contains routed disclosures with the following COI
Review Status:


Assigned Review Complete



Review Complete



Received in COI Office



Awaiting Additional Information

Click on the show button

to the right of Open Reviews to display disclosures.

Figure - Central Admin / Pre-Submission Compliance / Disclosures Under Review > Open Reviews With No
Financial Entities



Print & Approve Actions: Click on the
button in the first column to display
details about the disclosure and the review status. For Open Reviews with no
financial entities, print and a quick approve action is provided. Approve action
serves to move the disclosure to an approved status (Disclosure Status: Review
Completed).

For Open Reviews with financial entities, only the print option is provided.
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Figure - Central Admin / Pre-Submission Compliance / Disclosures Under Review > Open Reviews With
Financial Entities



Open the disclosure: Click on the hyperlinked number within the Disclosure Number
column to open the disclosure. Once the disclosure is open the COI Administrator
can perform appropriate action on it.

 Pending Reviews: The Pending Reviews panel contains disclosures that have a COI Review
status of “Submitted for Review”. Click on the show button to the right of Pending Reviews to
display the disclosures.

Figure - Central Admin / Pre-Submission Compliance / Disclosures Under Review > Pending Reviews With No
Financial Entities



Print & Approve Actions: Click on the show button
in the first column to
display details about the disclosure and the review status. For Pending Reviews with
no financial entities, print and a quick approve action is provided. Approve action
serves to move the disclosure to an approved status (Disclosure Status: Review
Completed).

For Pending Reviews with financial entities, only the print option is provided.
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Figure - Central Admin / Pre-Submission Compliance / Disclosures Under Review > Pending Reviews With
Financial Entities



Open the disclosure: Click on the hyperlinked disclosure number within the
Disclosure number column to open the disclosure. Once the disclosure is open
the COI Administrator can perform appropriate action on it.

 Work in Progress Reviews: The Work in Progress Reviews panel contains disclosures that have a
COI Review status of “Assigned to Reviewer” or “Under Review by COI Reviewer”. Click on the
show button to the right of Work in Progress Reviews to display the disclosures.

Figure - Central Admin / Pre-Submission Compliance / Disclosures Under Review > Work in Progress Reviews With
Financial Entities



Print & Approve Actions: Click on the show button
in the first column to
display details about the disclosure and the review status. For Work in Progress
Reviews with no financial entities, print and a quick approve actions is provided. The
Approve action serves to move the disclosure to an approved status (Disclosure
Status: Review Completed).
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Open the disclosure: Click on the hyperlinked disclosure number within the Disclosure
number column to open the disclosure. Once the disclosure is open the COI
Administrator can perform appropriate action on it.
Implementer’s Note: Implementing institutions can control which review status
disclosures will appear within the Work in Progress Reviews look-up. The system
provides a parameter WORK_IN_PROGRESS_REVIEW_STATUSES which takes in the
numeric values for Review Status Codes for the Maintenance Table COI Review Status as
parameter values.

Person Search: The COI Administrator can use this lookup to view the disclosures of any
Reporter within the system.


To access this lookup, navigate to Central Admin > Pre-Submission Compliance > Person
Search.

Table – Disclosures Under Review – Open Reviews, Pending Reviews, Work In Progress Reviews – Field Descriptions

Field

Description

Disclosure Number

This number is the unique number identifying this Disclosure. The number is unique for each reporter, but
subsequent disclosures use the same Disclosure Number, with a sequence number to make the disclosure
unique. This is a system generated, sequential number.

Owned By

NetID of the person who has submitted the disclosure.

Department

Name of the primary Department of the person who has submitted the disclosure.

Last Update

Date and timestamp of when the disclosure was updated with a save action in the system.

Expiration Date

Auto-populated date one calendar year after the “Submit Date” date.

Event Type

Type of disclosure submitted – Annual, Proposal, Institutional Proposal, Award, or Travel.

Event #

Number associated with the disclosure event. For disclosures affiliated with research projects, the
Proposal, Institutional Proposal, or Award number is listed; for Travel Disclosures, a sequential number is
listed.

Review Status

Status of the disclosure in the review process.

Last Update

Date and timestamp of when the disclosure was updated with a save action in the system.

Submit Date

Date and timestamp of when the disclosure was submitted.
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Figure - Central Admin / Pre-Submission Compliance / Person Search



Click on the lookup icon to the right of Person Search to access any Reporter’s
disclosures. Various search parameters are provided to refine the search results. The
Return Value column in the search results provides a link for the COI Administrator to
open the disclosure for any Reporter.

Figure - Central Admin / Pre-Submission Compliance / Person Search



Once you click on the “return value” link for a Reporter, the Reporter’s disclosure opens.
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New Projects for Disclosure (Project Disclosure)
The Complete Disclosure for a Research Proposal link takes the user to the New Projects for Disclosure
page. This page provides a list of projects that are identified as requiring disclosure for financial conflict
of interest. A Project Disclosure includes disclosures made in regard to any KC Proposal, Institutional
Proposal, or Award. The following instructions for Project Disclosure apply to any disclosure initiated by
following the Complete Disclosures for a Research Proposal link.
The KC system utilizes the status of the records as the mechanism to generate the items appearing on
the new project lists. For example, Development Proposals that have been submitted into workflow for
review and approval may appear as requiring a disclosure, but works that are still In Progress may not.
Additionally, fully approved and submitted Development Proposals would not appear in the Proposals
list, but in the Institutional Proposal list.
To access this page, the Reporter navigates the following path:
Researcher > Conflict of Interest > COI Disclosures > Complete Disclosure for a Research Proposal.

Figure -Researcher > Conflict of Interest > My Disclosures > New Project Disclosures to Complete

The New Projects for Disclosure page contains subpanels for three project disclosure types: Proposals,
Institutional Proposals, and Awards.

Figure - COI New Projects for Disclosure > collapse all view
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Factors that trigger a project to appear within “New Projects For Disclosure”
The appearance of Proposals, Institutional Proposals, and Awards hinges upon three main factors – the
individual project status codes, whether the project is sponsored by a particular sponsor or all sponsors,
and the relationship of certain projects (proposal, institutional proposal, and award) in Medusa.
 Project Status Codes
The following parameters accessible through System Admin allow institutes to choose which
project statuses they want to appear within the list of new projects to disclose:
PROPOSAL_DISCLOSE_STATUS_CODES
AWARD_DISCLOSE_STATUS_CODES
INSTITUTIONAL_PROPOSAL_DISCLOSE_STATUS_CODES
PROTOCOL_DISCLOSE_STATUS_CODES
IACUC_DISCLOSE_STATUS_CODES

For example, the parameter PROPOSAL_DISCLOSE_STATUS_CODE contains the values 1; 2; 3;
4; 5; 6; 8; 13. These values relate to the Proposal Status values maintained within the
Maintenance table Proposal Development Status. A proposal development status value of “1”
stands for “In Progress”. Having the value “1” in the list of status values in
PROPOSAL_DISCLOSE_STATUS_CODE, means that proposal which are in progress will appear
within the New Projects for Disclosure.
 Project Sponsor
Kuali Coeus can be configured to trigger a project disclosure for specific sponsors or for all
Sponsors. The following parameters accessible through System Admin enable this feature:
SPONSORS_FOR_PROPOSAL_AWD_DISCLOSE
SPONSORS_FOR_PROTOCOL_DISCLOSE
ALL_SPONSORS_FOR_PROPOSAL_AWD_DISCLOSE
ALL_SPONSORS_FOR_PROTOCOL_DISCLOSE
ALL_SPONSORS_FOR_IACUC_PROTOCOL_DISCLOSE
For example to trigger disclosures only for proposals sponsored only by NIH, the parameter
ALL_SPONSORS_FOR_PROPOSAL_AWD_DISCLOSE should be set to “N” to indicate that only
specific sponsors should trigger a proposal or award disclosure. The parameter
SPONSORS_FOR_PROPOSAL_AWD_DISCLOSE should contain a term that cross-references to the
Sponsor Hierarchy Maintenance table. If the value “COI Disclosures” is defined as parameter
value for SPONSORS_FOR_PROPOSAL_AWD_DISCLOSE, the Sponsor Hierarchy maintenance
table should contain the sponsor value for “NIH” under a Sponsor Hierarchy value of “COI
Disclosures”.
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Figure - System Admin page/Parameters/ALL_SPONSORS_FOR_PROPOSAL_AWD_DISCLOSE

Figure -System Admin page/Parameters/SPONSORS_FOR_PROPOSAL_AWD_DISCLOSE

Figure - KC Maintenance/Miscellaneous/Sponsor Hierarchy

 Medusa linkage
For projects (Proposals, Institutional Proposals, and wards) linked through Medusa, if a
disclosure has been submitted for either Proposal, Institutional Proposal, or Award, the
Reporter is not asked to disclose for the other projects.
Consider the scenario where a Reporter opens New Projects for Disclosure and finds a
Proposal, Institutional Proposal, and Award (which are all linked through Medusa). If the
Reporter creates and submits a disclosure for one of the projects, and then the Reporter reopens New Projects for Disclosure, the other projects linked through Medusa do not appear
anymore.
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Figure - COI New Projects for Disclosure

New Projects for Disclosure Panel

Figure - COI New Proposals for Disclosure > hidden view

These three panels list the type of projects to be disclosed – Proposals, Institutional Proposals, and
Awards. Expand the panel by clicking the
toggle button.

Figure - COI New Proposals for Disclosure

The New Proposals for disclosure panel displays the Reporter’s Proposal List. The identifying information
includes Proposal Number, Proposal Title, Sponsor, Start Date, End Date, and Action.
Table - COI New Proposals for Disclosure > label descriptions

Field
Proposal Number

Description
The system-generated number assigned to this development proposal

Kuali Coeus 5.2.1 User Guide—Conflict of Interest Section

74

Field

Description
document.

Proposal Name

The title of the proposal as entered by the Aggregator.

Sponsor

The name of the sponsor applied to this proposal.

Start Date

The proposed start date for this project

End Date

The proposed end date for this project

Action

Click on “Report Coi” to begin the New Proposal (event) Disclosure.

Figure - COI New Institutional Proposals for Disclosure

The New Institutional Proposals for disclosure panel displays the Reporter’s Institutional Proposal List.
The identifying information includes Institutional Proposal Number, Institutional Proposal Title, Sponsor,
Start Date, End Date, and Action.
Table - New Institutional Proposal Disclosure > Field label definitions

Field

Description

Institutional Proposal
Number

The system-generated number assigned to the development proposal
document when it became an institutionally submitted record.

Institutional Proposal Title

The name of the proposal as entered by the Aggregator in the
Development Proposal.

Sponsor

The name of the sponsor applied to this proposal.

Start Date

The proposed start date for this project.

End Date

The proposed end date for this project.

Figure -COI New Awards Disclosure > Disclosure sub-panel expanded to show details

This panel will list the Awards to be disclosed. Expand the Awards sub-panel by clicking the
toggle button. The New Awards for disclosure panel displays the Reporter’s Award List. The identifying
information includes Award Number, Award Title, Award Date, and Action.
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Table -COI New Awards Disclosure > Disclosure sub-panel> Award List label definitions.

Field

Description

Award Number

The system-generated number assigned to the award document when it
was created.

Award Title

The title of the Award. (This may have come from the IP record, but can be
entered/revised by the Award Administrator).

Award Date

The start date for this award.

Action

Click on “Report Coi” to begin the New Award (event) Disclosure.

Maintenance note: The awards in the list are determined by the Status codes maintained in the Config
Parameter AWARD_DISCLOSE_STATUS_CODES.

Create a New Project Disclosure
Expand the appropriate panel, locate the Proposal you want to address and then click the Report Coi link
in the Action column. This will open a new disclosure entry document. The document header contains
the Document ID, Status, Disposition, and Reporter: Created, Last Updated, and Disclosure Number.
During the disclosure process, you will complete the following steps:
 Review your details in the Reporter panel
 Review and maintain additional units, if needed, in the Unit Details subpanel
 Answer some questions in the Questionnaire panel, if defined (MSU has implemented one
question on the Screening Questionnaire panel)
 Relate your Financial Entities to your projects in the Projects & Financial Entity Relationships
panel
 Enter a note or upload a document in the Notes & Attachments panel
 Certify that the information is complete in the Certification panel
 Answer the follow-up question about other SFI’s to report
 (Potentially) Disclose additional SFI’s and complete the disclosure
The subpanel data requirements are described in the sections below.

Kuali Coeus 5.2.1 User Guide—Conflict of Interest Section

76

Figure - New Proposal Disclosure > Disclosure tab > collapsed view.

Reporter
The Reporter’s information comes from the Person data associated with the logged in user. If any of the
contact details are incorrect, they can be updated in KC by a user with the appropriate roles via the
navigation path, System Admin > Identity > Person. Most KC implementations update/maintain this
Person data table with a regularly scheduled HR Data feed. The Reporter must have one unit designated
as a Lead. Units may be added, deleted, and designated as lead for use with the Financial Entities in that
subpanel, but changes here will not impact or update the Person record.

Figure - New Proposal Disclosure > Disclosure tab > Reporter Contact Information

Contact Information
The Reporter’s Contact Information is display only, populated from the Person data associated with the
logged in user. If the information is incorrect, it can be updated in KC by a user with the appropriate
roles via the navigation path, System Admin > Identity > Person.
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Table - Financial Entities > Reporter Tab > Reporter Panel > Contact Information Subpanel– Field Descriptions

Field

Description

Full Name

Name of the person who is logged into KC, and is reporting a financial interest in an entity.

User Name

The name with which the User is able to log in to the KC application.

Email Address

Logged-in User's work email address.

Office Phone

Logged-in User's work phone number.

Primary Title

Logged-in User's primary work title, or primary job title.

Directory Title

Logged-in User's work title used in the institution directory; job title as recorded in the employee directory
maintained by the HR department.

Home Unit

Automatically populated with the primary dept. code in the Person data record of the logged-in User.

School

The name of the institution where the logged-in User is employed, and/or the school within the institution
where the User works.

eRA Commons
User Name

Login for NIH researchers: 6-20 characters, letter/numbers, no special characters.

Fax

The fax number of the logged-in User.

Pager

The pager number of the logged-in User.

Mobile

The mobile number of the logged-in User.

Office Location

The primary office location of the logged-in User.

Secondary
Office Location

The secondary office location of the logged-in User.

Address Line 1

Line one of the primary work address of the logged-in User.

Address Line 2

Line two of the primary work address of the logged-in User.

Address Line 3

Line three of the primary work address of the logged-in User.

City

The city of the primary work address of the logged-in User.

County

The county of the primary work address of the logged-in User.

State

The State of the primary work address of the logged-in User.

Postal Code

The postal code of the primary work address of the logged-in User.

Country

The country of the primary work address of the logged-in User.

Unit Details
The Unit Details are populated from the Reporter’s Person record. Existing units may be added, deleted,
and the designated lead unit modified for use with the Financial Entities, but changes here will not
impact or update the Person record. One unit must be designated as the Reporter’s Lead Unit by clicking
one box in the Lead column.

Figure - New Proposal Disclosure > Disclosure tab > Reporter Unit Details
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Table - Financial Entities > Reporter Tab > Reporter Panel > Unit Details Subpanel – Field Descriptions

Field

Description

Unit Name

Unit name the User identifies as his/her educational institution affiliation.

Unit Number

Populated by the selection made from the Unit Name Lookup; displays hyphenated descriptor of parent unitschool/dept.

Lead

Checkbox to designate the Reporter's lead or primary unit.

COI Training Information
The COI Training Information subpanel is used to maintain a record of the date and type of training that
was completed. The information is entered manually by the COI Administrator, and the information may
then be viewed by anyone with access to the disclosure.

Figure - Financial Entities > Reporter Tab > Reporter Panel > COI Training Information Subpanel – Example

Table - Financial Entities > Reporter Tab > Reporter Panel > COI Training Information Subpanel– Field Descriptions

Field

Description

COI Training
Completion Date

The calendar date that the Reporter completed the COI training tutorial.

COI Training Type

The type of the completed COI training tutorial (usually online).

Screening Questionnaire
The Screening Questionnaire allows Reporters who have no relationships with financial entities a quick
path to certification and submission of the disclosure.

Figure - New Proposal Disclosure > Disclosure Page > Screening Questionnaire sub-panel - contents shown; screening
questionnaire incomplete

To complete the screening questionnaire, expand the sub-panel by clicking the
toggle button
and then answer the question. Once the screening questionnaire has been successfully completed, the
title band will update to Complete.
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Figure - New proposal disclosure > Disclosure Page > Screening Questionnaire sub-panel - contents shown

Screening Questionnaire Business Rules: The screening question response by the Reporter is analyzed
by the system to determine whether the Reporter requires to define a financial entity or not. Note that
the screening questionnaire could contain a number of questions, but MSU has implemented with only
one question. The system performs the following check:
 If the Reporter responds “No” to the screening question, they are not required to have an
existing financial entity or create a financial entity within the system. After responding to the
screening question they can directly go to certification panel and submit the disclosure.
 If the Reporter responds with a “Yes” to the screening question, they are required to have an
existing financial entity or to create the financial entity prior to certifying and submitting the
disclosure. For Reporters who answer “Yes” to the screening question and don’t have an active
financial entity, the system displays the following message:

KRMS Note: The Screening Questionnaire Business Rule is enforced through the Kuali Rule
Management System (KRMS). A business rule condition has been created to trigger a validation
error if the number of Yes responses is greater than or equal to 1 and the number of financial
entities is zero. This KRMS rule can be changed by implementing institutions to suit their business
needs. For example, an implementing school might want to add additional conditions to the existing
screening question business rule or change the error to a warning. Consult the technical support
team to change the KRMS rules.
Maintenance note: Screening questionnaires are created and maintained through Questionnaire
Maintenance. To create a Screening Questionnaire, create a questionnaire with the appropriate
(Yes/No) type screening questions and define a usage of Module as COI Disclosure and a Module Sub
Item Code of Screening. The implementing school might choose to make the questionnaire mandatory
or optional through the Mandatory Column.

Figure - Maintenance/Questionnaire/COI Screening Questionnaire/Usage
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Once the Screening Questionnaire has been deployed for COI, the same Screening Question will
appear in all the COI disclosure types (such as project, travel, and annual). To create different
Screening Questionnaires for different disclosure types, a Kuali Rule Management System
(KRMS) rule can be created to check the disclosure type. Once the KRMS rule has been created,
the rule can be connected to the Questionnaire usage through the Rule ID column in the
Questionnaire usage section.

Figure - Maintenance/Questionnaire/COI Screening Questionnaire/Usage/Rule ID

Since the system does not enforce the rule that only question with “Yes/No” response type
should be defined within the Screening Questionnaire – for the screening question functionality to
work, implementing institutions must ensure that only questions with “Yes/No” in the response type
are defined within the Screening Questionnaire.

Project & Financial Entity Relationships
This panel contains two subpanels. Expand the panel by clicking the
toggle button. The upper
subpanel displays the proposal to be related to a Reporter’s active Financial Entities. The lower subpanel
displays the list of financial entities. The parenthetical text in this banner keeps track of the number of
entities that must be reviewed to complete this subpanel’s requirements. Example: (0/2 Reviews
Complete). When the entities in this subpanel have been related, the banner text will update.

Figure - New Proposal Disclosure > Disclosure tab > Project & Financial Entity Relationships sub-panel expanded

This subpanel of the Disclosure page displays the Reporter’s Proposal details and a subpanel for the
Financial Entities. The Proposal Name, Sponsor, Start & End Date, and PI Name are displayed to identify
the proposal. The Financial Entities subpanel displays the following four columns: Review, Entity,
Related to this Project?, and Comments. The overall disclosure disposition
for
the project is also displayed on the header panel.
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Table - COI Annual Disclosures > Disclosure Page > Disclosed Projects (Grouped by Projects)>Financial Entities Column layout

Field

Description

Review

The column that contains buttons to allow COI Reviewers and COI Administrators to view reported
information about the financial entity (view button) or view history about the financial entity (history
button).

Entity

The column that lists the name of the financial entity.

Related to
this Project?

The column that contains a drop-down list allowing the Reporter to select the financial entity’s
relationship to the project, lists the Reporter’s selection of the financial entity’s relationship, or lists
the COI Administrator’s determination of the financial entity’s relationship.

Comments

A text box containing comments provided about any financial entity in relation to the project.

Adoption of Project-Financial Entity relatedness status with the highest numerical value as project and
disclosure status
The system uses the numeric code assigned to each COI Disposition Code to determine which
disposition code is displayed in the header panel for each project and the header panel for the
disclosure. The relationship with the highest code number is displayed in the header. Higher values were
assigned to the more “serious” relationships (i.e., those with possible or known conflict of interest) so
the most serious type of relationship is shown in project and disclosure headers.

COI Disposition Code

COI Disposition

100

In progress

200

Not Related

210

No Conflict Exists

240

Disclosed Interests Managed

300

Under COI Office Review

303

Under COI Committee Review

305

Awaiting Additional Information

310

Potential Relationship

320

Relationship Identified

400

Disclosed Interests
Unmanageable

501

Not Reviewed

502

Reviewed contact FCOI

As shown in the example below, the COI Disposition value for value for “Potential Relationship” 310 is
higher than the COI Disposition value for “No Conflict Exists” 210. Hence the system adopts the higher
value status for the project level disclosure status.
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The Status of the Disclosure on the header panel is derived from the project-FE status with the highest
value.

Figure - New Proposal Disclosure > Header panel > Status

Notifications
Any notifications triggered by the disclosure action for which the logged-in user is one of the notification
recipients will be displayed in the Notification panel.

Figure -New Proposal Disclosure > Disclosure tab > Notifications

Table – New Proposal Disclosure > Disclosure tab > Notifications Panel > Disclosure Notifications

Field

Description

Type

The type of action taken within Kuali Coeus.

Recipients

The NetIDs of the recipients who will receive the notification.

Subject

The subject line of the notification being sent.

Date Sent

The date the notification is sent.
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Notes & Attachments Panel – Project Disclosure
The Notes & Attachments panel of the Disclosure page allows you to add textual notes and attach
external files to a Disclosure document.

Figure - New Proposal Disclosure > Disclosure tab > Notes & Attachments

Notes:

Figure - New Proposal Disclosure > Disclosure tab > Notes

1. To create a note, enter a Note Topic (this field is required in order to create a note).
2. Write the note in the Note Text field provided.
3. Indicate the type of note from the Note Type field – you can select from PI Entry, Reviewer
Comment, and COI Officer. This is an optional field.
4. If the note pertains to one of your listed projects, you may select it from the drop-down list in
the Project column.
5. If the note pertains to one of your active financial entities, you may select it from the drop-down
list in the Financial Entity column.
6. The Restricted column is only active for the COI Administrator and Reviewers.
7. Click the Add button in the Action column to save this note entry.

Figure - New Proposal Disclosure > Disclosure tab > completed note added.

Once added, the note will appear in the subpanel. You can edit the note topic and text by clicking the
edit button. Or you can delete the note by clicking the delete button.
Table - New Proposal Disclosure > Disclosure tab > Notes column layout

Field

Description

Created By

User name and date and time stamp when the note was posted.

Updated By

User name and date and time stamp when the note was last updated.

Note Topic

Displays the topic of the note as entered by the author. Required field for saving a note.

Note Text

Displays the text of the note entered by the author. Required field for saving a note.

Note Type

Displays the drop-down option selected by the author to identify whether the note was entered
by a PI, by a Reviewer, or by the COI office.
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Field

Description

Project

Read-only field where the project title for the project in which the note is being created is autopopulated.

Financial Entity

Displays the drop-down option selected by the author if he or she identified whether the note was
related to a reported financial entity.

Restricted?

Notes that are flagged as restricted by either a Reviewer or by COI Administrator are not viewable
by the Reporter, but are viewable to COI Administrator and Reviewers. Field displays "true" when
note is restricted, and "false" when unrestricted.

Actions

Actions that are available on notes. On an approved disclosure, this field is empty, because the
approved disclosure is read-only.

Attachments

Figure -New Proposal Disclosure > Disclosure tab > Attachments entry subpanel

1. To attach a document, select an Attachment Type from the drop-down list.
2. If desired, you may enter a contact name, email, and phone number in the fields provided.
3. If the attachment pertains to a listed project, financial entity, or both, you may select one from
the drop down list.
4. Enter a comment in the text field, if desired.
5. A description of the attachment is required in the Description field.
6. Use the “Choose File” button to search for and select the document to upload.
7. Click the Add button to complete this attachment upload.
Once added, you can expand the subpanel to view, replace or delete the attachment.

Figure -New Proposal Disclosure > Disclosure tab > Attachment added
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Table - New Proposal Disclosure > Disclosure tab >New Attachment fields

Field

Description

Attachment Type

Drop-down field where user can sort all attachments to display by either description, date of last
update, who updated, or no sort at all.

Contact Name

User views read-only information on every document attached to his or her Annual Disclosure,
and can also view the attached document.

Uploaded By

Read-only field that displays to the user the type of attachment: PI Submission, Management
Plan, or Other.

Posted Timestamp

Read-only field that displays to the user the name of the person who may be contacted
regarding the attached file.

Comments

Read-only field that displays to the user the project to which the attached file pertains.

File Name

Read-only field that displays to the user the entity to which the attached file pertains.

Project

Read-only field populated with the user name of the person who uploaded the attached file.

Email

Read-only field that displays to the user the email address of the person who may be contacted
regarding the attached file.

Phone

Read-only field populated with the time and date the file was originally attached.

Description

Read-only field that displays to the user the phone number of the person who may be contacted
regarding the attached file.

Financial Entity

Read-only field that displays to the user any comments related to the attachment.

Certification: New Proposal Disclosure
To fulfill the certification requirement, expand the panel by clicking the

toggle button.

Maintenance note: the text for the certification statement is maintained in the Config parameter:
COI_CERTIFICATION_STATEMENT

The text for the certification acknowledgement checkbox section is maintained in the Config parameter:
COI_CERTIFICATION_ACKNOWLEDGEMENT

Figure - New Proposal Disclosure > Disclosure tab > Certification sub-panel, hidden

The Certification panel displays a statement regarding disclosure of significant financial interests that
those responsible for the research may have. It is provided for you to read and then acknowledge
electronically that you have read by submitting a certification.
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Figure - New Proposal Disclosure > Disclosure tab > Certification sub-panel, expanded, not yet certified.

Once you have read both the statement and the acknowledgement, check the box. Once the
acknowledgment check-box is clicked, the submit button will appear.

Figure - New Proposal Disclosure > Disclosure tab > Certification sub-panel, check-box detail, not yet certified.

Click the submit button to complete this disclosure. Your completed disclosure updates the Certification
panel with your name and the date of the certification. Click the close button at the bottom of the page
to return to the Reporter page.

Data Validation: Project Disclosure
If upon clicking Submit, you receive an error message, click the Save button to have the system present
the Validation subpanel.
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Figure - New Proposal Disclosure > Disclosure tab >data validation errors > click Save to view the Data Validation panel

Data Validation subpanel

Figure - New Proposal Disclosure > Data Validation sub-panel

To resolve disclosure validation errors, expand the Validation Errors > Disclosure subpanel by clicking
the
toggle button.

Figure - New Proposal Disclosure > Data Validation> validation error details and fix navigation

Click the Fix button to return to the disclosure to make the corrections.
Alternatively, click the Disclosure tab at the top of the page to be returned to the disclosure.
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If the Questionnaire has been deemed mandatory, you must answer all the questions prior to
submitting the disclosure.
Entity Status: If you have any financial entities, all the entities must be reviewed and their
relationship status to the project must be maintained prior to submitting the disclosure.

Once you have completed all the required disclosure data elements, click the certify checkbox and then
click the submit button to complete this disclosure.

Figure - New Proposal Disclosure > Disclosure tab > Certification sub-panel, check-box detail, not yet certified.

Click the submit button to complete this disclosure. After clicking the submit button, a question appears
saying, “Do you have any other…” Answer the question and your completed disclosure updates the
Certification panel with your name and the date of the certification.
Click the close button at the bottom of the page to return to the Reporter page.
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Travel Disclosure

Figure -Researcher >Conflict of Interest > My Disclosures > Create Manual Disclosure navigation

MSU has configured KC so that the only “manual event” possible is a Travel Disclosure. The link to access
the Travel Disclosure page is accessed via the Reporter tab> Conflict of Interest Channel> Complete
Sponsored / Reimbursed Travel Event under the COI Disclosures section. The KC COI Disclosure page is
presented containing the system generated document header details above the single Disclosure tab.
Five panels are presented to the Reporter: Reporter; Manual Event and Financial Entities; Notifications;
Notes & Attachments; and Certification. After a travel event is added, the Screening Questionnaire
appears.
During the disclosure process, you will complete the following steps:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Review details in the Reporter panel.
Review and maintain additional units, if needed, in the Unit Details subpanel.
Select the type of disclosure in the Manual Event and Financial Entities panel.
Enter the specifics about the travel event in the New Event Project subpanel and click the
add button.
Make a selection for each of your Financial Entities to indicate its relationship to this travel
event in the Financial Entities subpanel.
Answer the Screening Questionnaire.
Enter a note or upload a document, if appropriate, in the Notes & Attachments panel.
Certify that the information is complete in the Certification panel and submit the Travel
Disclosure.
Answer the question presented regarding any other significant financial interests.
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10. (Potentially) Disclose further SFIs and complete the disclosure.
The panel data requirements are described in the panels below.

Figure -Conflict of Interest > My Disclosures > Create Manual Disclosure > Disclosure tab

Reporter Panel: Travel Disclosure
The Reporter’s information comes from the Person data associated with the logged in user. If any of the
contact details are incorrect, they can be updated in KC by a user with the appropriate roles via the
navigation path: System Admin > Identity > Person. Most KC implementations update/maintain this
Person data table with a regularly scheduled HR Data feed. The Reporter must have one unit designated
as a Lead. Units may be added, deleted, and designated as lead for use with the Financial Entities in that
subsection, but changes here will not impact or update the Person record.

Figure -COI > Create Manual Disclosure > Disclosure tab > Reviewer Contact info

Contact Information Subpanel: Travel Disclosure
The Reporter’s Contact Information is display only, populated from the Person data associated with the
logged in user. If any of the contact details are incorrect, they can be updated in KC by a user with the
appropriate roles via the navigation path: System Admin > Identity > Person.
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Table - COI > Create Manual Disclosure > Disclosure tab > Reviewer Contact info – Field Descriptions

Field

Description

Full Name

Name of the person who is logged into KC, and is reporting a financial interest in an entity.

User Name

The name with which the User is able to log in to the KC application.

Email Address

Logged-in User's work email address.

Office Phone

Logged-in User's work phone number.

Primary Title

Logged-in User's primary work title, or primary job title.

Directory Title

Logged-in User's work title used in the institution directory; job title as recorded in the employee directory
maintained by the HR department.

Home Unit

Automatically populated with the primary dept. code in the Person data record of the logged-in User.

School

The name of the institution where the logged-in User is employed, and/or the school within the institution
where the User works.

eRA Commons
User Name

Login for NIH researchers: 6-20 characters, letter/numbers, no special characters.

Fax

The fax number of the logged-in User.

Pager

The pager number of the logged-in User.

Mobile

The mobile number of the logged-in User.

Office Location

The primary office location of the logged-in User.

Secondary
Office Location

The secondary office location of the logged-in User.

Address Line 1

Line one of the primary work address of the logged-in User.

Address Line 2

Line two of the primary work address of the logged-in User.

Address Line 3

Line three of the primary work address of the logged-in User.

City

The city of the primary work address of the logged-in User.

County

The county of the primary work address of the logged-in User.

State

The State of the primary work address of the logged-in User.

Postal Code

The postal code of the primary work address of the logged-in User.

Country

The country of the primary work address of the logged-in User.

Unit Details Subpanel: Travel Disclosure
The Unit Details are populated from the Reporter’s Person record. Existing units may be added, deleted,
and the designated lead unit modified, but changes here will not impact or update the Person record.
One unit must be designated as the Reporter’s Lead Unit by clicking one box in the Lead column.

Figure -COI > Create Manual Disclosure > Disclosure > Reporter Unit info
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Table - COI > Create Manual Disclosure > Disclosure > Reporter Unit info – Field Descriptions

Field

Description

Unit Name

Unit name the User identifies as his/her educational institution affiliation.

Unit Number

Populated by the selection made from the Unit Name Lookup; Displays hyphenated descriptor of parent unitschool/dept.

Lead

Checkbox to designate the Reporter's lead, or primary unit.

COI Training Information Subpanel
The COI Training Information subpanel is used to maintain a record of the date and type of training that
was completed. The information is entered manually by the COI Administrator, and the information may
then be viewed by anyone with access to the COI area.

Figure - Financial Entities > Reporter Tab > Reporter Panel > COI Training Information Subpanel – Example
Table - Financial Entities > Reporter Tab > Reporter Panel > COI Training Information Subpanel – Field Descriptions

Field

Description

COI Training
Completion Date

The calendar date that the Reporter completed the COI training tutorial.

COI Training Type

The format of the completed COI training (generally, online).

Manual Event & Financial Entity Panel: Travel Disclosure
Expand the sub-panel by clicking the

toggle button.

Select a Travel Disclosure from the Event Type drop-down list. Once selected, the data requirement
fields will appear in the subpanel. Enter the required fields and then click the Add button.

Figure - COI > Create Manual Disclosure > Disclosure tab > Manual Event and Financial Entities sub-panel prior to selecting an
event type

Once the Travel Event Type has been successfully added, subsections for the travel details and the
financial entities will appear.
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Figure -COI> Manual Event & Financial Entities sub-panel with Travel Disclosure Event type selected.

The New Event Project subpanel requires the following data fields to be maintained:
Table - COI> Manual Travel Event Disclosure > new project details field definitions

Field
Event Type
Event Title

Description
System-assigned: Travel Disclosure.
User-entered name for the sponsored travel event.

Destination/Location of
Travel

Name of the location or destination of the travel event.

Sponsor Name

Name of the sponsor/entity providing funds for the travel event.

Amount of
reimbursement
received

Funding amount received from the sponsor for the travel event.

Purpose of Travel

Reason for the travel event.

Start Date

Date the travel began.

End Date

Date the travel ended.

Once the Travel Event has been successfully added, subpanels for the project details and the financial
entities will appear. Complete the requirements in all subpanels.

Figure - COI> Travel Disclosure Event triggers the Manual Event & Financial Entities sub-panel
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After adding the travel event information (clicking the add button), the Manual Event and Financial
Entities panel contains two subpanels:


Event Id: with identifying number. Displays the recently entered travel event.



Financial Entities (0/1 Reviews Complete). Displays list of the user’s active financial entities. The
parenthetical text in this banner keeps track of the number of entities that must be reviewed to
complete this subpanel’s requirements. When the entities in this subpanel have been related,
the banner text will update. The Financial Entities subpanel displays the following four columns:
Review, Entity, Related to this Project?, and Comments.

The Reporter must select from the drop-down menu below “Related to this Project?” to indicate
whether each financial entity has sponsored this travel event.
Table - COI> Manual Travel event Financial Entities field definitions

Field

Description

Review

This column contains the View, Edit, and History function buttons that allow the user to access the
details of the financial entity.
Read-only name of the financial entity, as previously entered by user.

Entity
Related to
this Project?

Drop-down menu that allows user to select and apply to each of the user's reported entities
individually, the degree of relatedness between each entity and the sponsored travel event.

Comments

Text field where the user can enter any comments providing additional information on the connection
between each entity and the sponsored travel event.

Adoption of Project-FE relatedness status with the highest numerical value as project and disclosure
status
When multiple financial entities are related to a project, the system adopts the highest number of the
project-FE statuses selected by the Reporter for the status display at the project and disclosure level.
This can be seen after the Reporter selects the project-FE relationship and performs a save action.
The statuses No Conflict Exists, Potential Relationships and Relationships Identified are
maintained within the Maintenance Table COI Disposition Status. The calculation of which
project-FE status to select as the overall status for the project/disclosure is based on the value
of the numeric COI Disposition Code. Higher numbered codes have been assigned to statuses
that are considered more “serious” – those with potential or actual conflict of interest.

COI Disposition Code

COI Disposition

210

No Conflict Exists

310

Potential Relationship

320

Relationship Identified
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As shown in the list above, the COI Disposition value for value for “Potential Relationship” (310 is higher
than the COI Disposition value for “No Conflict Exists” (210). Hence the system adopts the higher value
status for the project level disclosure status.
The Status of the Disclosure on the header panel is derived from the project-FE status with the highest
value.

Figure - COI > Manual travel event > Disclosure header > Status

Completing the Travel Disclosure
To complete the travel event disclosure, relate the financial entities, answer the questionnaire, maintain
any notes or attachments as needed, and proceed to the Certification sub-panel. See the instructions for
certification.

Notifications Panel
Any notifications triggered by the disclosure action for which the logged-in user is one of the notification
recipients will be displayed in the Notification subpanel of the disclosure. The example below shows the
notification for a manual award disclosure.

Figure -COI > Manual event disclosure > Disclosure page > Notifications

Table – COI > Manual event disclosure > Notifications

Field

Description

Type

The type of action taken within Kuali Coeus.

Recipients

The NetIDs of the recipients who will receive the notification.

Subject

The subject line of the notification being sent.

Date Sent

The date the notification is sent.
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Notes & Attachments Panel: Travel Disclosure
The Notes & Attachments panel of the Disclosure page allows you to add textual notes and attach
external files to a Disclosure document.

Figure - COI > Manual Event Disclosure > Notes & Attachments panel

Notes:

Figure - COI > Manual Event Disclosure > Notes

1. To create a note, enter a Note Topic (this field is required in order to create a note).
2. Write the note in the Note Text field provided (this field is also required in order to create a
note).
3. Indicate the type of note from the Note Type field – you can select from PI Entry, Reviewer
Comment, and COI Officer. This is an optional field.
4. If the note pertains to one of your listed projects, you may select it from the drop-down list
in the Project column.
5. If the note pertains to one of your active financial entities, you may select it from the dropdown list in the Financial Entity column.
6. The Restricted column is only active for the COI Administrator and Reviewers.
7. Click the Add button in the Action column to save this note entry.

Figure - COI > Manual Event Disclosure > completed note added.

Once added, the note will appear in the subpanel. You can edit the note topic and text by clicking the
edit button. Or you can delete the note by clicking the delete button.
Table - COI > Manual Event Disclosure > Notes column layout

Field

Description

Created By

User name and date and time stamp when the note was posted.

Updated By

User name and date and time stamp when the note was last updated.

Note Topic

Displays the topic of the note as entered by the author. Required field for saving a note.

Note Text

Displays the text of the note entered by the author. Required field for saving a note.

Note Type

Displays the drop-down option selected by the author to identify whether the note was entered
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Field

Description
by a PI, by a Reviewer, or by the COI office.

Project

Read-only field where the project title for the project in which the note is being created is autopopulated.

Financial Entity

Displays the drop-down option selected by the author if he or she identified whether the note was
related to a reported financial entity.

Restricted?

Notes that are flagged as restricted by either a reviewer or by COI Administrator are not viewable
by the Reporter, but are viewable to COI Administrator and reviewers. Field displays "true" when
note is restricted, and "false" when unrestricted.

Actions

Actions that are available on notes. On an approved disclosure, this field is empty, because the
approved disclosure is read-only.

Attachments

Figure - COI > Manual Event Disclosure > Attachments entry subpanel

1. To attach a document, select an Attachment Type from the drop-down list.
2. If desired, you may enter a contact name, email, and phone number in the fields provided.
3. If the attachment pertains to a listed project, financial entity, or both, you may select one from
the drop down list.
4. Enter a comment in the text field, if desired.
5. A description of the attachment is required in the Description field.
6. Use the “Choose File” button to search for and select the document to upload.
7. Click the Add button to complete this attachment upload.
Once added, you can expand the subpanel to view, replace or delete the attachment.

Figure - COI > Manual Event Disclosure > Attachment added
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Table - COI > Manual Event Disclosure >New Attachment fields

Field

Description

Attachment Type

Drop-down field where user can sort all attachments to display by either description, date of last
update, who updated, or no sort at all.

Contact Name

User views read-only information on every document attached to his or her Annual Disclosure,
and can also view the attached document.

Uploaded By

Read-only field that displays to the user the type of attachment: PI Submission, Management
Plan, or Other.

Posted Timestamp

Read-only field that displays to the user the name of the person who may be contacted
regarding the attached file.

Comments

Read-only field that displays to the user the project to which the attached file pertains.

File Name

Read-only field that displays to the user the entity to which the attached file pertains.

Project

Read-only field populated with the user name of the person who uploaded the attached file.

Email

Read-only field that displays to the user the email address of the person who may be contacted
regarding the attached file.

Phone

Read-only field populated with the time and date the file was originally attached.

Description

Read-only field that displays to the user the phone number of the person who may be contacted
regarding the attached file.

Financial Entity

Read-only field that displays to the user any comments related to the attachment.

Certification Panel: Travel Disclosure
Maintenance note: the text for the certification statement is maintained in the Config parameter:
COI_CERTIFICATION_STATEMENT

The text for the certification acknowledgement checkbox subpanel is maintained in the Config
parameter: COI_CERTIFICATION_ACKNOWLEDGEMENT

Figure - COI > Manual Disclosure > Certification sub-panel

The Certification panel displays a statement regarding disclosure of significant financial interests.
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Figure -COI > Manual Disclosure Certification sub-panel expanded.

Once you have read both the statement and the acknowledgement, check the box. After the
acknowledgment checkbox is clicked, the submit button will appear.

Figure - COI > Manual Disclosure Certification acknowledgment subpanel with box checked to present “submit” button

Click the submit button to complete this disclosure. Your completed disclosure updates the Certification
panel with your name and the date of the certification.
Click the close button at the bottom of the page.
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Data Validation Panel: Travel Disclosure
If, upon clicking Submit, you receive an error message, click the Save button to have the system present
the Validation subpanel.

Figure - COI > Manual Disclosure > Data Validation error

The Disclosure Data Validation panel

Figure -COI > Manual Disclosure > Data Validation > Validation Error

To resolve disclosure validation errors, expand the Validation Errors > Disclosure sub-panel by clicking
the
toggle button.
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Figure -COI > Manual Disclosure > Data Validation> Disclosure errors

Click the Fix button to return to the disclosure to make the corrections. Alternatively, click the Disclosure
tab at the top of the page to be returned to the disclosure.



If the Questionnaire has been deemed mandatory, you must answer the question in the
Questionnaire prior to submitting the disclosure. (MSU has implemented a mandatory
Screening Questionnaire with only one question.)
Entity Status: If you have any financial entities, all the entities must be reviewed and their
relationship status to the project must be maintained prior to submitting the disclosure.

Once you have completed all the required disclosure data elements, click the certify checkbox and then
click the submit button to complete this disclosure.

Click the submit button to complete this disclosure. After submitting, anser the question, “Do you have
any other…” Then your completed disclosure updates the Certification subpanel with your name and the
date of the certification.
Click the close button at the bottom of the page to return to the Reporter page.
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Updating a COI Disclosure

Figure -Reporter > Conflict of Interest > COI Disclosures > Update My COI Disclosure

After a Reporter has submitted their first Annual Disclosure in KC, and that disclosure has been
approved, all future disclosures can be considered to be updates in the KC system. Clicking the Update
My COI Disclosure link opens the KC COI Disclosure page. If the Reporter clicks the Create New/Annual
Disclosure link, the same KC COI Disclosure page is displayed. The page will include all previously
reported projects and travel disclosures, along with all of the Reporter’s active financial entities.
Updating an Annual Disclosure is the same as described in the section of this manual for Creating Annual
Disclosure, beginning on (approximately) page 54.
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